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preface

USING THIS GUIDE

This Maintenance and Service Guide is a troubleshooting guide that can be used for
reference when servicing the Compaq Armada 1700 Family of Personal Computers.

&RPSDT�&RPSXWHU�&RUSRUDWLRQ�UHVHUYHV�WKH�ULJKW�WR�PDNH�FKDQJHV�WR�WKLV�SURGXFW

ZLWKRXW�QRWLFH�

$GGLWLRQDO�LQIRUPDWLRQ�LV�DYDLODEOH�RQ�WKH�&RPSDT�$UPDGD������)DPLO\�RI�3HUVRQDO

&RPSXWHUV�,OOXVWUDWHG�3DUWV�0DS�

Symbols

7KH�IROORZLQJ�ZRUGV�DQG�V\PEROV�PDUN�VSHFLDO�PHVVDJHV�WKURXJKRXW�WKLV�JXLGH�

! WARNING:��Text set off in this manner indicates that failure to follow directions in the
warning could result in bodily harm or loss of life.

CAUTION:  Text set off in this manner indicates that failure to follow directions in the
caution could result in damage to equipment or loss of information.

IMPORTANT:  7H[W�VHW�RII�LQ�WKLV�PDQQHU�SUHVHQWV�FODULI\LQJ�LQIRUPDWLRQ�RU�VSHFLILF

LQVWUXFWLRQV�

NOTE:  7H[W�VHW�RII�LQ�WKLV�PDQQHU�SUHVHQWV�FRPPHQWDU\��VLGHOLJKWV��RU�LQWHUHVWLQJ�SRLQWV�RI

LQIRUPDWLRQ�
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Technician Notes

! WARNING:��Only authorized technicians trained by Compaq should attempt to repair this
equipment. All troubleshooting and repair procedures are detailed to allow only
subassembly/module level repair. Because of the complexity of the individual boards and
subassemblies, no one should attempt to make repairs at the component level or to
make modifications to any printed wiring board. Improper repairs can create a safety
hazard. Any indication of component replacement or printed wiring board modifications
may void any warranty or exchange allowances.

! WARNING:��The computer is designed to be electrically grounded. To ensure proper
operation, plug the AC power cord into a properly grounded electrical outlet only.

CAUTION:��To properly ventilate your system, you must provide at least 3 inches
(7.62 cm) of clearance on the left and right sides of the computer.

Serial Number

:KHQ�UHTXHVWLQJ�LQIRUPDWLRQ�RU�RUGHULQJ�VSDUH�SDUWV��SURYLGH�WKH�FRPSXWHU�VHULDO

QXPEHU��7KH�VHULDO�QXPEHU�LV�RQ�WKH�EDFN�RI�WKH�FRPSXWHU�

Laser Safety

$OO�&RPSDT�V\VWHPV�HTXLSSHG�ZLWK�&'�520�GULYHV�FRPSO\�ZLWK�DSSURSULDWH�VDIHW\

VWDQGDUGV��LQFOXGLQJ�,(&�������:LWK�VSHFLILF�UHJDUG�WR�WKH�ODVHU��WKH�HTXLSPHQW�FRPSOLHV

ZLWK�ODVHU�SURGXFW�SHUIRUPDQFH�VWDQGDUGV�VHW�E\�JRYHUQPHQW�DJHQFLHV�DV�D�&ODVV���ODVHU

SURGXFW��,W�GRHV�QRW�HPLW�KD]DUGRXV�OLJKW��WKH�EHDP�LV�WRWDOO\�HQFORVHG�GXULQJ�DOO�PRGHV�RI

FXVWRPHU�RSHUDWLRQ�DQG�PDLQWHQDQFH�

CDRH Regulations

7KH�&HQWHU�IRU�'HYLFHV�DQG�5DGLRORJLFDO�+HDOWK��&'5+��RI�WKH�8�6��)RRG�DQG�'UXJ

$GPLQLVWUDWLRQ�LPSOHPHQWHG�UHJXODWLRQV�IRU�ODVHU�SURGXFWV�RQ�$XJXVW����������7KHVH

UHJXODWLRQV�DSSO\�WR�ODVHU�SURGXFWV�PDQXIDFWXUHG�IURP�$XJXVW����������&RPSOLDQFH�LV

PDQGDWRU\�IRU�SURGXFWV�PDUNHWHG�LQ�WKH�8QLWHG�6WDWHV�

! WARNING:  8VH�RI�FRQWUROV�RU�DGMXVWPHQWV�RU�SHUIRUPDQFH�RI�SURFHGXUHV
RWKHU�WKDQ�WKRVH�VSHFLILHG�KHUHLQ�RU�LQ�WKH�&'�520�LQVWDOODWLRQ�JXLGH�PD\
UHVXOW�LQ�KD]DUGRXV�UDGLDWLRQ�H[SRVXUH�
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7KLV�V\VWHP�LV�FODVVLILHG�DV�D�&/$66���/$6(5�352'8&7��7KLV�ODEHO�LV�ORFDWHG�RQ

WKH�RXWVLGH�RI�WKH�V\VWHP�EHLQJ�VHUYLFHG��$�VLPLODU�ODEHO�DOVR�DSSHDUV�RQ�WKH�LQWHUQDO�&'�

520�LQVWDOOHG�LQ�WKH�V\VWHP�

/$6(5�,1)2

/DVHU�7\SH� 6HPLFRQGXFWRU��*D$,$V

:DYH�/HQJWK� �����������QP

'LYHUJHQFH�$QJOH� �����'HJUHH���������'HJUHH

2XWSXW�3RZHU� /HVV�WKDQ�0.2mW or 10,869 Wxm-2sr-1

3RODUL]DWLRQ� &LUFXODU

1XPHULFDO�$SHUWXUH� �������������

2QO\�DQ�DXWKRUL]HG�WHFKQLFLDQ��VHUYLFH�SURYLGHU��GHDOHU��RU�UHVHOOHU�VKRXOG�DWWHPSW�WR

UHSDLU�WKLV�HTXLSPHQW��$OO�WURXEOHVKRRWLQJ�DQG�UHSDLU�SURFHGXUHV�DUH�GHWDLOHG�WR�DOORZ

RQO\�VXEDVVHPEO\�PRGXOH�OHYHO�UHSDLU��%HFDXVH�RI�WKH�FRPSOH[LW\�RI�WKH�LQGLYLGXDO

ERDUGV�DQG�VXEDVVHPEOLHV��QR�RQH�VKRXOG�DWWHPSW�WR�PDNH�UHSDLUV�DW�WKH�FRPSRQHQW�OHYHO

RU�WR�PDNH�PRGLILFDWLRQV�WR�DQ\�SULQWHG�ZLULQJ�ERDUG��,PSURSHU�UHSDLUV�FDQ�FUHDWH�D�VDIHW\

KD]DUG�DV�ZHOO�DV�YRLG�WKH�ZDUUDQW\�

Battery Notice

! WARNING:  This computer contains an internal lithium battery-powered real-
time clock circuit. There is a risk of explosion and injury if the battery is incorrectly
replaced or improperly handled. Do not attempt to  recharge, disassemble,
immerse in water, or dispose of the battery in fire. Replacement should be done
using the Compaq spare part for this computer.

! WARNING:  The computer also contains a lithium-ion battery pack. There is a
risk of fire and chemical burn if the battery pack is handled improperly. Do not
disassemble, crush, puncture, short external contacts, dispose of in fire or water,
or expose this battery to temperatures higher than 60 degrees C.

,Q�1RUWK�$PHULFD��GLVSRVH�RI�QLFNHO�PHWDO�K\GULGH�RU�OLWKLXP�LRQ�EDWWHULHV�E\�WDNLQJ

DGYDQWDJH�RI�WKH�&RPSDT�EDWWHU\�UHF\FOLQJ�SURJUDP��<RX�ZLOO�EH�SURYLGHG�ZLWK�D

SRVWDJH�SDLG�EDWWHU\�SDFN�PDLOHU�SUHDGGUHVVHG�WR�D�UHFODPDWLRQ�IDFLOLW\�ZKHUH�WKH�PHWDOV

DUH�UHF\FOHG�

,Q�(XURSH��GR�QRW�GLVSRVH�RI�EDWWHULHV�DQG

DFFXPXODWRUV�ZLWK�JHQHUDO�KRXVHKROG�ZDVWH�

'LVSRVH�RI�RU�UHF\FOH�WKHP�E\�XVLQJ�WKH�SXEOLF

FROOHFWLRQ�V\VWHP�RU�UHWXUQLQJ�WKHP�WR�&RPSDT�
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Serial Number

7KH�VHULDO�QXPEHU�LV�ORFDWHG�RQ�WKH�EDFN�RI�WKH�FRPSXWHU�GLUHFWO\�EHORZ�WKH�SDUDOOHO

FRQQHFWRU�

Locating Additional Information

7KH�IROORZLQJ�GRFXPHQWDWLRQ�LV�DYDLODEOH�WR�VXSSRUW�WKH�FRPSXWHU�

■ Compaq Armada 1700 Family of Personal Computers documentation set

■ Microsoft operating system guide

■ Compaq service advisories and bulletins

■ Compaq QuickFind

■ Compaq Service Quick Reference Guide

■ Technical Reference Guide

■ Illustrated Parts Map

■ Compaq Internet site at http://www.Compaq.com
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chapter
 1

PRODUCT DESCRIPTION

1.1  Computer Features and Models

The Armada 1700 Family of Personal Computers is a line of multimedia notebook
computers with advanced modularity, processors, and video graphics. This full-
function, Mobile Pentium II-based family of notebook computers allows full desktop
functionality and connectivity through the use of an optional Convenience Base.

Figure 1-1. Armada 1700 Personal Computer
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1.1.1 Features

The computer models have the following standard features:

■ 233-MHz or 266-MHz Mobile Pentium II processors

■ 32-MB of synchronous dynamic random access memory (SDRAM), expandable to
160 MB

■ 4.0-GB, 2.5- inch internal hard drive mounted in carrier

■ LCD displays:

❏ 12.1 inch SVGA CTFT display

❏ 13.3-inch XGA CTFT display

■ Supports Lithium Ion (Li-ion) battery packs

■ Internal stereo speakers

■ Internal microphone

■ Full-size 101 key compatible keyboard including 12 function keys, 8 cursor control
keys, inverted-T cursor control keys, and embedded numeric keypad

■ Four user-programmable keys

■ Touchpad pointing device

■ Operates from a battery pack in the battery bay, plus an optional battery pack in the
MultiBay, or integrated AC power supply that is compatible with domestic or
international power sources

■ Power management and security features

■ Infrared interface for wireless communication with other IrDA-compliant devices at
data rates up to 4 mb/sec1 (available on selected models)

■ Two standard device slots that will accommodate two Type II or one Type III PC
Card, PCMCIA card or CardBus card. The Compaq telephony modem is supported
in the top slot and Zoomed-Video in the bottom slot

■ 176-pin expansion connector provides the interface to the convenience base options

■ Rear-panel ports provide connections for parallel, serial, external monitor, and
keyboard/mouse

■ Universal Serial Bus (USB)

1.1.2 Models

Compaq Armada 1700 computers are configurable, and may contain any or all of the
features listed. All models have 32-MB of standard memory, and may be upgraded to
160-MB.

1.1.3 Software Fulfillment

Replacement software may be ordered directly from Compaq Computer Corporation.
Both the model and the serial number of the computer are needed to identify the
specific software available.
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1.2  Computer Options

The computer supports the following options:

■ Convenience Base II pass through model with monitor stand

■ Convenience Base II with Ethernet with monitor stand

■ Compatible with Convenience Base models from the Armada 1500 Family of
Personal Computers

■ Memory expansion boards

■ Li-ion battery pack

■ Automobile/Aircraft Adapter

■ External Battery Charger

■ PCMCIA modem

■ Hard drive upgrade

■ Hard drive adapter for MultiBay with carrying case

■ Internal modem

■ CD-ROM drive for Optical Disc Bay

■ DVD drive for optical Disc Bay

■ 120-MB LS-120 diskette drive for MultiBay

■ 100-MB Zip drive for MultiBay

1.2.1 Convenience Base II

Armada 1700 models support the following convenience base models:

■ Convenience Base II pass through

■ Convenience Base II with Ethernet

1.2.2 System Memory Options

The computer supports optional 16-, 32-, 64-, and 128-MB memory boards. The
memory boards are 66-MHz SDRAM without parity. System memory can be expanded
to 160-MB, depending on the model.

                                                                                                                                                                                                        
1 Windows 95 supports up to 115-kb/sec. Driver for 4 mb/sec available from www.microsoft.com.
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1.2.3 External Battery Charger

The external battery charger has the following features:

■ Two battery charge slots

■ Accepts Li-ion modular batteries

■ Charges one battery in 1.5 hours

■ Charges two batteries in 3 hours

Note: The battery calibration process should be used to discharge the batteries.

1.2.4 External Keyboards and Pointing Devices

Supports Compaq or Compaq compatible PS2 keyboards and pointing devices.

1.2.5 External Monitors

■ Supports all VGA Monitors at resolutions up to 1280 u 1024

■ Supports DDC1 and DDC2b compliant Energy Star monitors

1.3  External Computer Components

The external computer components are illustrated and described in this section.
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1.3.1 Left Side Components

The left side external components are shown in Figure 1-2 and are described in Table 1-1.

Figure 1-2. Left Side Components

Table 1-1
Armada 1700 Computer Components

Left Side

Item Component Function

1 Cable Lock Secures computer to fixed object

2 Speaker/headphone jack Connects stereo speakers, headphone or headset

3 Microphone jack Connects external microphone, disables internal microphone

4 Volume up Increases volume

5 Volume down Decreases volume

6 Left bass reflex speaker port Enhances audio quality
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1.3.2 Front Components

The front external components are shown in Figure 1-3 and are described in Table 1-2.

Figure 1-3. Front Components

Table 1-2
Armada 1700 Computer Components

Front

Item Component Function

1 Display LCD graphic display

2 Lid switch Blanks display when display is closed

3 Speakers Produce high quality stereo sound

4 MultiBay Accepts diskette drive, LS-120 drive, ZIP drive, second battery
pack or second hard drive

5 Optical disk bay Accepts CD-ROM or DVD-ROM devices

6 Battery bay Accepts Li-Ion battery pack

7 Keyboard Accepts operator input

8 Microphone Monophonic microphone
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1.3.3 Top Components

The top external components are shown in Figure 1-4 and are described in Table 1-3.

Figure 1-4. Top Components

Table 1-3
Armada 1700 Computer Components

Top

Item Component Function

1 Lid switch Blanks display when display is closed

2 Programmable function buttons User programmable keys

3 Suspend Initiates suspend

4 Power switch Turns power on and off

5 Keyboard release latched Releases keyboard from system unit

6 Touchpad Pointing device
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1.3.4 Right Side Components

The right side external components are shown in Figure 1-5 and are described in
Table 1-4.

Figure 1-5. Right Side Components

Table 1-4
Armada 1700 Computer Components

Right Side

Item Component Function

1 Right bass reflex speaker port Enhances audio quality

2 PC Card eject button Eject PC Cards from the slots

3 PC Card slots Accepts 16- and 32-bit PC Cards

4 USB Connector Connects USB devices to the computer

5 Modem jack Connects the phone line to the computer (selected models)
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1.3.5 Rear Components

The rear components are shown Figure 1-6 and are described in Table 1-5.

Figure 1-6. Rear Components

Table 1-5
Armada 1700 Computer Components

Rear

Item Component Function

1 Parallel connector Connects parallel devices such as a printer

2 Serial connector Connects serial devices such as a mouse

3 Infrared port Provides wireless communications (on selected models)

4 External monitor connector Connects external monitor

5 AC Power connector Connects external AC power

6 Docking connector Provides connection to optional convenience base

7 Fan (Airflow vents) Provides thermal ventilation to internal components

8 External Keyboard Connects external keyboard or PS-2 mouse
(Supports standard Y connector)
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1.3.6 Bottom Components

The bottom external components are shown in Figure 1-7 and are described in
Table 1-6.

Figure 1-7. Bottom Components

Table 1-6
Armada 1700 Computer Components

Bottom

Item Component Function

1 Modem compartment Integrated modem (selected models)

3 Docking alignment guide Aligns computer to optional convenience base

2 Docking latch receptacles Locks computer to optional convenience base

4 Tilt feet Adjusts computer to an angle

5 MultiBay screw Secures MultiBay Devices

6 Hard drive cover Covers hard drive compartment

* Hard drive security screw Secures hard drive cover (not shown)
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1.3.7 Status Panel Lights

The status panel lights are shown in Figure 1-8 and described in
Table 1-7.

Figure 1-8. Status Panel Lights

Table 1-7
Armada 1700 Computer Components

Status Panel

Item Component Function

1 Hard drive activity light Indicates hard drive or CD-ROM access

2 MultiBay activity light Indicates MultiBay device activity

3 Number lock indicator Indicates that numbers lock is on

4 Caps lock indicator Indicates that caps lock is on

5 Scroll lock indicator Indicates that scroll lock is on



1-12    Product Description

1.4  Design Overview

This section presents a design overview of the computer. The overview is limited to
field replaceable parts. All replacement parts are listed in Chapter 3.

1.4.1 System Unit

The computer is a traditional clamshell design with a display assembly attached to a
system unit. The computer opens to reveal a backlit LCD display and a full-function
keyboard. The display is designed for a continuously adjustable tilt angle.

1.4.2 Internal Boards

The system electronics are integrated on four printed circuit assemblies: the audio/led
board, system board, modem board, and the DC-DC converter board.

■ The audio/led board provides support for the audio functions.

■ The system board integrates the processor, on-board memory, level 2 cache, local
bus video adapter, and PCMCIA/CardBus adapter.

■ The optional modem board supports data or fax functions.

■ The DC-DC converter board creates the system voltages (3.3v and 5v) from the
battery or AC/DC input.

Processor

An Intel Mobile Pentium II processor is located on the system board for the 233 MHz
and 266 MHz models.

Memory

Base memory is 32-MB with 16-, 32-, 64-, or 128-MB of optional expansion memory.
Base memory is onboard memory built into the system board. Expansion memory
consists of one memory expansion board available as a user installable option.

Cache

Level 2 cache is integrated in the CPU module. It is not user upgradable.

PCMCIA/CardBus and Video Adapter Controller

The PCMCIA/CardBus adapter is based on the Texas Instrument PCI1220 PC to
CardBus controller unit. The local bus video adapter is the Chips and Technologies
65555 controller.

■ The serial-parallel port board expands the serial and parallel signals from the system
board to the serial and parallel expansion connectors.

■ The audio/led board supports the microphone and headphone jacks, the volume
control switches, and the amplifier and equalization circuitry.
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1.4.3 Video system

The standard video subsystem consists of:

■ An internal LCD Display

■ 12.1 inch SVGA CTFT display

■ 13.3 inch XGA CTFT display

■ 2 Megabyte frame buffer

■ An inverter to supply AC power to the LCD back-light system

■ A standard external VGA connector for use with CRTs and other VGA compatible
displays

■ 40 KByte Video ROM
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chapter
 2

TROUBLESHOOTING

Follow these basic steps when beginning the troubleshooting process:

1. Complete the preliminary steps listed in Section 2.1.
2. Run the Power-On Self-Test (POST) as described in Section 2.3.
3. Run Computer Setup as described in Section 2.5.
4. Run the Computer Checkup (TEST) as described in Section 2.6.
5. If you are unable to run POST or Computer Checkup or if the problem persists after

running POST and Computer Checkup, perform the recommended actions
described in the diagnostic tables in Section 2.5.

Follow these guidelines when troubleshooting:

■ Complete the recommended actions in the order in which they are given.

■ Repeat POST and Computer Checkup after each recommended action until the
problem is resolved and the error message does not return.

■ When the problem is resolved, stop performing the troubleshooting steps and do not
complete the remaining recommended actions.

■ Refer to Chapter 5 for removal and replacement procedures that are recommended.

■ If the problem is intermittent, check the computer several times to verify that the
problem is solved.

The following table describes the troubleshooting actions:

If You Want To: Then Run:

Check for POST error messages POST

Check that computer components are recognized and
running properly

Computer Checkup (TEST) under Compaq Utilities

View information about the computer and installed or
connected devices

View System Information (INSPECT) under
Compaq Utilities

Perform any of the following:

■ Check the system configuration

■ Set the system power management parameters

■ Return the system to its original configuration

■ Check system configuration of installed devices

Computer Setup
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2.1  Preliminary Steps

IMPORTANT:  Use AC power when running POST, Computer Setup, or Computer
Checkup. A low battery condition could initiate Hibernation and interrupt the test.

Before running POST and Computer Checkup, complete the following steps:

1. Obtain established passwords. If you must clear the passwords, go to Section 2.2.
2. Ensure that the hard drive is installed in the computer.
3. Ensure that the battery pack is installed in the computer and the power cord is

connected to the computer and plugged into an AC power source.
4. Turn on the computer.
5. If a power-on password has been established, type the password and press Enter.

6. Run Computer Setup (Section 2.5). If a Setup password has been established, type
the password and press Enter.

7. Turn off the computer and all external devices.
8. Disconnect external devices that you do not want to test. If you want to use the

printer to log error messages, leave it connected to the computer.

NOTE:  If a problem only occurs when an external device is connected to the computer,
the problem could be with the external device or its cable. Isolate the problem by
running POST with and without the external device connected.

9. Use Compaq Utilities and loopback plugs in the serial and parallel connectors if you
plan to test these ports.

Follow these steps to run Compaq Utilities:

a. If you are running Compaq Utilities from the hard drive, turn on or restart the
computer. Press F10 when the cursor appears in the upper right corner of the
screen. If you do not press F10 in time, restart the computer and try again.

If you are running Compaq Utilities from diskette, insert the Compaq Utilities
diskette in drive A. Turn on or restart the computer.

b. Press Enter to accept OK.

c. Select Computer Checkup (TEST).

d. Select Prompted Diagnostics.

e. After “Identifying System Hardware” completes, select Interactive Testing and
follow the instructions on the screen.
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2.2  Clearing Passwords

The power-on password prevents use of the computer until the password is entered. The
setup password prevents unauthorized changes to Computer Setup. To clear the
passwords, you must remove all power from the system board. If you do not know the
passwords, use the following procedure to clear the password:

1. Remove all battery packs from the battery bay and MultiBay, if applicable.
2. Disconnect the AC power.
3. Remove the real-time clock battery.
4. Wait five minutes.
5. Reconnect the AC power.
6. Restart the computer. During Power-On Self Test (POST), a “162 System Options

not set” message appears.
7. Shut down the computer, then disconnect AC power again.
8. Replace the real-time clock battery.
9. Install the battery pack(s).
10. Proceed with the troubleshooting procedures.

2.3  Power-On Self-Test (POST)

The Power-On Self-Test (POST) is a series of tests that run every time the computer is
turned on. POST verifies that the system is configured and functioning properly.

To run POST, complete the following steps:

1. Complete the preliminary steps (Section 2.1).
2. Turn on the computer.

If POST does not detect any errors, the computer beeps once or twice to indicate that
POST has run successfully. The computer boots from the hard drive or from a bootable
diskette if one is installed in the diskette drive.

2.4  POST Error Messages

If the system is not functioning well enough to run POST, or if the display is not
functioning well enough to show POST error messages, refer to the Troubleshooting
tables in Section 2.6.

If POST detects an error, one of the following events occurs:

■ A message with the prefix "WARNING" appears informing you where the error
occurred. The system pauses until you press F1 to continue.

■ A message with the prefix "FATAL" appears informing you where the error
occurred. After the message, the system emits a series of beeps and stops.

■ The system emits a series of beeps and stops.
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Warning messages indicate that a potential problem, such as a system configuration
error, exists. When F1 is pressed, the system should resume. You should be able to
correct problems that produce WARNING messages.

IMPORTANT:  When a WARNING message includes the prompt to "RUN SCU," press
F10 to run Computer Setup. (Computer Setup replaces the SCU utility.)
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If you receive one of the error messages listed below, follow the recommended action.

Table 2-1
Warning Messages

Message Description Recommended Action

CMOS checksum invalid, run SCU CMOS RAM information has
been corrupted.

Run Computer Setup to reinitialize
CMOS-RAM.

CMOS failure, run SCU CMOS RAM has lost power. Run Computer Setup to reinitialize
CMOS-RAM.

Diskette controller error The diskette drive controller
failed to respond to the
recalibrate command.

If there is no diskette drive in the
system, run Computer Setup to
properly configure the CMOS-RAM to
show no diskette drive present. If the
problem persists, or if a diskette drive
is present, complete these steps until
the problems is solved:

1. Check diskette drive connections.

2. Replace diskette drive.

3. Replace system board.

Diskette track 0 failed The diskette drive cannot read
track 0 of the diskette in the
drive.

Try another diskette. If the problem
persists, you may need to replace the
diskette drive.

Hard disk controller error The hard drive controller failed
to respond to the reset
command.

Check the drive parameters. Turn off
the system and check all related
connections.

Keyboard controller failure The keyboard failed the self-
test command.

Replace the system board.

Keyboard failure The keyboard failed to respond
to the RESET ID command.

Replace the keyboard. If the problem
persists, replace the system board.

No interrupts from Timer 0 The periodic timer interrupt is
not occurring.

Replace the system board.

ROM at xxxx (LENGTH yyyy) with
nonzero checksum (zz)

An illegal adapter ROM was
located at the specified
address.

Check the external adapter (such as a
video card) to determine if it is
causing the conflict.

Time/Date corrupt - run SCU The time and date stored in the
real time clock have been
corrupted, possibly by a power
loss.

1. Run Computer Setup.

2. If problem persists, replace
auxiliary battery.

3. If problems persists, replace
system board.

Hard disk xx failure (or error) A failure or an error occurred
when trying to access the hard
drive.

1. Run Scan disk.

2. Check disk in DOS and
Windows 95. If problem persists,
refer to Table 2-10.

Unsupported memory module An EDO memory module was
installed in the memory
expansion slot.

Remove the EDO memory module
and replace with SDRAM memory
module.
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Fatal errors emit a beep and may display a FATAL message. Fatal errors indicate severe
problems, such as a hardware failure. Fatal errors do not allow the system to resume.
Some of the Fatal error beep codes are listed at the end of this section.

Table 2-2
Fatal Error Messages

Message Description Beep Code

CMOS RAM test failed A walking bit test of CMOS RAM location 0E
(Hex) - 3F (Hex) failed.

3

DMA controller faulty A sequential read/write of the transfer count
and transfer address registers within the
primary and secondary DMA controllers failed.

4

Faulty DMA page registers A walking bit read/write of the 16 DMA
controller page registers starting at location
80 Hex failed.

0

Faulty refresh circuits A continuous read/write test of port 61h found
that bit 4 (Refresh Detect) failed to toggle
within an allotted amount of time.

1

Interrupt controller failed A sequential read/write of various Interrupt
Controller registers failed.

5

ROM checksum incorrect A checksum of the ROM BIOS does not match
the byte value at F000:FFFF.

2

RAM error at location xxxx RAM error occurred during memory test. None

Table 2-3
Fatal Error Beep Codes

Beep Code Beep Sequence Description Recommended Action

0 S-S-S-P-S-S-L-P The DMA page registers are
faulty.

Replace system board.

1 S-S-S-P-S-L-S-P The refresh circuitry is faulty.

2 S-S-S-P-S-L-L-P The ROM checksum is incorrect.

3 S-S-S-P-L-S-S-P The CMOS RAM test failed.

4 S-S-S-P-L-S-L-P The DMA controller is faulty.

5 S-S-S-P-L-L-S-P The interrupt controller failed.

6 S-S-S-P-L-L-L-P The keyboard controller failed.

7 S-S-L-P-S-S-S-P Graphics adapter is faulty.

8 S-S-L-P-S-S-L-P Internal RAM is faulty. Replace memory board or
system board if memory on
system board is faulty.

S = Short, L = Long, P = Pause
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2.5  Compaq Utilities

Compaq Utilities contain several functions that

■ Determine if various computer devices are recognized by the system and are
operating properly.

■ Provide information about the system once it is configured.

Compaq Utilities include the following programs:

■ Computer Setup

■ Computer Checkup (TEST)

■ View System Information (INSPECT)

To access Compaq Utilities:

1. Turn on or restart the computer by clicking Start ⇒ Shut Down ⇒ Restart the
computer.

2. Press F10 when the blinking cursor appears in the upper-right corner of the display.
3. Select a menu option.

Computer Setup

Computer Setup contains utilities that give you an overall picture of the computer
hardware configuration and aid in troubleshooting. These utilities also allow you to set
custom features such as security options, power conservation levels, and startup
preferences.

If you are running Windows 95, the computer automatically recognizes and configures
the system for new devices. If you have a configuration problem or want to view or
reset configuration settings, you can use Computer Setup.

NOTE:  If you are running Windows 95, you should use Computer Setup only to adjust
system features such as the power-on password or battery conservation level. Windows
95 may override other configuration changes.

If you are running Windows NT, the computer does not automatically recognize new
devices added to the system. All devices ordered with your system have been
configured for you. Use Computer Setup to view settings for a new device you have
added or to reset configuration settings for preinstalled devices.

Computer Setup provides two methods of viewing the computer configuration:  by type
(factory setting) or connection.
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Categories by type:

■ System Features—security, power, boot management

■ Communication—port, modem, and other communication devices

■ Storage—storage-related devices such as hard drive, CD-ROM drive, diskette drive

■ Input Devices—keyboard, mouse, and other input devices

■ Network—network adapter or other network-related devices

■ Audio—sound properties and audio device settings

■ Video—display timeouts and video device resources

■ Other—miscellaneous devices

Categories by connection:

■ System Features—security, power, boot management

■ System Devices—keyboard, mouse, parallel and serial ports

■ ISA—ISA bus and connected devices

■ PCI—PCI bus and connected devices

■ PC Card—PC Card devices

Running Computer Setup

1. Turn on or restart the computer by clicking Start ⇒ Shut Down ⇒ Restart the
computer.

2. Press F10 when the blinking cursor appears in the upper-right corner of the screen.
 NOTE:  If you a setup password is enabled, it must be used to access Computer Setup.
3. Click a language and press Enter.

4. Click Computer Setup and press Enter.

5. When you are finished, click Exit.
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Exiting Computer Setup

1. Click Exit.

2. Select one of the following Exit options:

■ Save—Saves the new settings and exits Computer Setup.

NOTE:  Some settings may not take effect until the computer is restarted.
■ Ignore—Exits Computer Setup and restores previous settings.

■ Cancel—Returns to Computer Setup.

Computer Checkup (TEST)

Computer Checkup (TEST) determines whether the various computer components and
devices are recognized by the computer and are functioning properly. You can display,
print, or save the information that Computer Checkup generates.

NOTE:  Compaq Utilities are intended for testing only Compaq-supplied components.
Testing of non-Compaq components may be inconclusive.

Running Computer Checkup (TEST)

1. Plug the computer into an external power source. A low battery condition can
interrupt the program.

2. Connect a printer if you want to print a log of error messages.
3. Turn on the external devices that you want to test.
4. Turn on or restart the computer.
5. Access Compaq Utilities by pressing F10 when the blinking cursor appears in the

upper-right corner of the display.
6. Click Computer Checkup ⇒ View the Device List.

■ If the list of installed devices is correct, click OK.

■ If the list is incorrect, ensure that any new devices are installed properly.

7. Select one of the following from the Test Option menu:

■ Quick Check Diagnostics

■ Automatic Diagnostics

■ Prompted Diagnostics

8. Follow the instructions on the screen as the devices are tested.
9. Click Exit Diagnostics ⇒ Exit from this utility.
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Computer Checkup (TEST) Error Codes

Computer Checkup (TEST) error codes occur if the system recognizes a problem while
running Computer Checkup. These error codes help identify possible defective
assemblies. Tables 2-4 through 2-14 list Computer Checkup error codes, a description
of the error condition, and the recommended action for resolving the condition. For
removal and replacement procedures, refer to Chapter 5.

IMPORTANT:  Run Computer Checkup each time you complete a recommended action
step. If the problem is resolved when POST and Computer Checkup are rerun (i.e., with
no error codes), do not perform the remaining recommended action steps.

NOTE:  The error codes in the following tables are listed in an “AYE-XX” format,
where:

A or AA = Number that represents the faulty assembly

 YY = Test or action that failed

 XX = Specific problem

Table 2-4
Processor Test Error Codes

Error Code Description Recommended Action

101-xx CPU test failed. Replace the processor board and retest.

103-xx DMA page registers test failed. Replace the system board and retest.

104-xx Interrupt controller master test failed.

105-xx Port 61 error.

106-xx Keyboard controller self-test failed.

107-xx CMOS RAM test failed.

108-xx CMOS interrupt test failed.

109-xx CMOS clock test failed.

110-xx Programmable timer load data test failed.

113-xx Protected mode test failed.
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Table 2-5
Memory Test Error Codes

Error Code Description Recommended Action

200-xx Memory machine ID test failed. The following steps apply to error codes 200-xx
and 202-xx:

202-xx Memory system CMOS checksum failed. 1. Flush the system CMOS and retest. See note.

2. Replace the system board and retest.

203-xx Write/Read test failed. The following applies to error codes 203-xx
through 215-xx:

204-xx Address test failed. Remove and replace the SODIMM memory board
or system board (if the memory on the system
board is faulty) and retest.

211-xx Random pattern test failed.

214-xx Noise test failed.

215-xx Random address test failed.

Table 2-6
Keyboard Test Error Codes

Error Code Description Recommended Action

300-xx Failed ID Test. 1. Reseat the keyboard assembly.

301-xx Failed Self test/Interface Test. 2. Replace the keyboard and retest.

302-xx Failed Individual Key Test. 3. Replace the system board and retest.

304-xx Failed Keyboard Repeat Test.

Table 2-7
Parallel Printer Test Error Codes

Error Code Description Recommended Action

401-xx Printer failed or not connected. 1. Connect the printer.

402-xx Failed Port Test. 2. Check power to the printer.

403-xx Printer pattern test failed. 3. Install the loopback connector and retest.

4. Check port and IRQ configuration.

5. Replace the system board and retest.

Note: Fn + F11 clears the ESCD configuration information. If the Fn + F11 sequence is
pressed very early after powering the machine on (after you see the keyboard LEDs
blink, but before the video is initialized), CMOS memory will be invalidated. The
ESCD is cleared, the machine is reset and boots with the "162 - System Options Not
Set" message. This is a way to clear out configuration information, such as Windows
95's knowledge about a docking station. It may help clear up problems if the
configuration information had been corrupted. Timing of this keystroke sequence is
critical, as there is a very narrow window during which the keys will be recognized.
These keys are not documented to users.
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Table 2-8
Diskette Drive Error Codes

Error Code Description Recommended Action

600-xx Diskette ID drive types test
failed.

The following steps apply to error codes 600-xx
through 698-xx:

601-xx Diskette format failed. 1. Replace the diskette.

602-xx Diskette read test failed. 2. Replace the diskette drive and retest.

603-xx Diskette write, read, compare test failed. 3. Replace the system board and retest.

604-xx Diskette random read test failed.

605-xx Diskette ID media test failed.

606-xx Diskette speed test failed.

609-xx Diskette reset controller test failed.

610-xx Diskette change line test failed.

697-xx Diskette type error.

698-xx Diskette drive speed not within limits.

699-xx Diskette drive/media ID error. 1. Replace media.

2. Run Compaq Utilities.

Table 2-9
Serial Test Error Codes

Error Code Description Recommended Action

1101-xx Serial port test failed. 1. Check port configuration.

2. Replace the system board and retest.

Table 2-10
Hard Drive Test Error Codes

Error Code Description Recommended Action

1701-xx Hard drive format test failed. 1. Run Compaq Utilities and verify drive type.

1702-xx Hard drive read test failed. 2. Verify that all secondary drives have
secondary drive capability.

1703-xx Hard drive write/read/compare test failed. 3. Replace the hard drive and retest.

1704-xx Hard drive random seek test failed. 4. Replace the system board and retest.

1705-xx Hard drive controller test failed.

1706-xx Hard drive ready test failed.

1707-xx Hard drive recalibration test failed.

1708-xx Hard drive format bad track test failed.

1709-xx Hard drive reset controller test failed.

1710-xx Hard drive park head test failed.

1715-xx Hard drive head select test failed.

1716-xx Hard drive conditional format test failed.

1717-xx Hard drive ECC* test failed.

1719-xx Hard drive power mode test failed.

1724-xx Network preparation test failed.

1736-xx Drive monitoring test failed.

* ECC = Error Correction Code
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Table 2-11
Video Test Error Codes

Error Code Description Recommended Action

501-xx Video controller test failed. The following actions apply to error codes 501-xx
through 516-xx:

502-xx Video memory test failed. 1. Disconnect external monitor and test with
internal LCD display.

503-xx Video attribute test failed. 2. Replace the display assembly and retest.

504-xx Video character set test failed. 3. Replace the system board and retest.

505-xx Video 80 × 25 mode 9 × 14 character
cell test failed.

506-xx Video 80 × 25 mode 8 × 8 character
cell test failed.

507-xx Video 40 × 25 mode test failed.

511-xx Video screen memory page test failed.

512-xx Video gray scale test failed.

514-xx Video white screen test failed.

516-xx Video noise pattern test failed.

2402-xx Video memory test failed. The following actions apply to error codes
2402-xx through 2456-xx:

2403-xx Video attribute test failed. 1. Run Compaq Utilities.

2404-xx Video character set test failed. 2. Disconnect external monitor and test with
internal LCD display.

2405-xx Video 80 × 25 mode 9 × 14 character cell
test failed.

3. Replace the display assembly and retest.

4. Replace the system board and retest.

2406-xx Video 80 × 25 mode 8 × 8 character cell
test failed.

2411-xx Video screen memory page test failed.

2412-xx Video gray scale test failed.

2414-xx Video white screen test failed.

2416-xx Video noise pattern test failed.

2418-xx ECG/VGC memory test failed.

2419-xx ECG/VGC ROM checksum test failed.

2421-xx ECG/VGC 640 × 200 graphics mode test
failed.

2422-xx ECG/VGC 640 × 350 16 color set test
failed.

2423-xx ECG/VGC 640 × 350 64 color set test
failed.

2424-xx ECG/VGC monochrome text mode test
failed.

2425-xx ECG/VGC monochrome graphics mode test
failed.

2431-xx 640 × 480 graphics test failed.

2448-xx Advanced VGA Controller test failed.

Continued
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Table 2-11  Continued

Error Code Description Recommended Action

2451-xx 132-column Advanced VGA test failed.

2456-xx Advanced VGA 256 Color test failed.

2458-xx Advanced VGA Bit BLT test failed. The following step action to error codes 2458-xx
to 2480-xx:

2468-xx Advanced VGA DAC test failed. Replace the system board and retest.

2477-xx Advanced VGA data path test failed.

2478-xx Advanced VGA BitBLT test failed.

2480-xx Advanced VGA Linedraw test failed.

Refer to Table 2-25 for information about other video errors.

Table 2-12
Audio Test Error Codes

Error Code Description Recommended Action

114-01 Speaker test failed. 1. Check system configuration.

2. Verify verify that the audio/led board is properly
seated.

3. Verify display audio cable connection.

3206-xx Audio System Internal Error Replace the audio board and retest.

Table 2-13
Pointing Device Interface Test Error Codes

Error Code Description Recommended Action

8601-xx Pointing device test failed. Replace the keyboard/CPU cover assembly.

8602-xx Interface test failed.

Table 2-14
CD-ROM Test Error Codes

Error Code Description Recommended Action

3301-xx CD-ROM drive read test failed. 1. Replace the CD and retest.

2. Verify that drivers are loaded and properly
installed.

3305-xx CD-ROM drive seek test failed. 3. Replace the CD-ROM drive and retest.

4. Replace the system board and retest.

6600-xx ID test failed.

6605-xx Read test failed.

6608-xx Controller test failed.

6623-xx Random read test failed.
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Running View System Information (INSPECT)

The View System Information (INSPECT) utility provides information about the
computer and installed or connected devices. You can display, print, or save the
information.

In order to access the INSPECT utility, follow the instructions below:

1. Connect a printer if you want to print the INSPECT information.
2. Turn on or restart the computer.
3. Access Compaq Utilities by pressing F10 when the cursor blinks in the upper-right

corner of the display.
4. If prompted, select a language.
5. Click View System Information (INSPECT).
6. Click the item you want to view. The list includes the following:

■  System ■  Audio
■  ROM ■  Operating system
■  Keyboard ■  System files
■  System ports ■  Windows files
■  System storage ■  Miscellaneous
■  Graphics
■  Memory

■  Network (applicable only if
computer is docked in the
Convenience Base II)

7. Follow the instructions on the screen to cycle through the screens, to return to the
list and choose another item, or to print the information.

8. Select Exit Inspect.
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Running Compaq Diagnostics

Compaq Diagnostics provides computer component information when the operating
system is working.

If you are running Windows 95, access Compaq Diagnostics for Windows by
double-clicking My Computer ⇒ Control Panel ⇒ Compaq Diagnostics.

Boot Sequencing

1. Run Computer Setup.
2. Click the System Features icon ⇒ Boot Management box ⇒ MultiBoot tab.
3. Designate the hard drive boot (startup) sequence you want.
4. Click OK to accept the changes.

Factory Default Settings

Initialization

Enable POST Memory Test Checked (enabled)

Keyboard num Lock Unchecked (Off)

1 Hard drive in the computer

2 Hard drive in the computer MultiBay

Boot display Auto

Language Language of country

Ports

Serial/infrared ports

Serial port 3F8, IRQ4

Infrared port 2F8, IRQ3

Parallel port 378, IRQ7

Ethernet port 300, IRQ9
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Power

Low Battery Warning Beep Checked (enabled)

External Energy Saving Monitor Connected Unchecked (not connected)

Power Management

Enabled While operating power on battery

Conservation Level Medium

Level Definition

High Suspend Time:  5 minutes

Hibernation Timeout:  Immediate

Drive Timeout:  2 minutes

Screen Timeout:  2 minutes

Medium Suspend Time:  10 minutes

Hibernation Timeout:  1 hour

Drive Timeout:  6 minutes

Screen Timeout:  4 minutes

Custom Suspend Time:  disabled

Hibernation Timeout:  low battery

Drive Timeout:  always on

Screen Timeout:  always on

Security

Enable QuickLock/QuickBlank Unchecked (Disabled)

Enable Power-On Password Unchecked (Disabled)

Disable Serial/Infrared Ports Unchecked (Enabled)

Disable Parallel Port Unchecked (Enabled)

Disable PC Card Slots Unchecked (Enabled)

Setup Password Password blank

Power-On Password Password blank

Diskette Drives

Disable Diskette Drives Unchecked (Enabled)

Disable Diskette Boot Unchecked (Enabled)
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2.6  Troubleshooting Without Diagnostics

This section provides information about how to identify and correct some common
hardware, memory, and software problems. It also explains several types of messages
that may be displayed on the screen.

Since symptoms can appear to be similar, carefully match the symptoms of the computer
malfunction against the problem description in the Troubleshooting tables to avoid a
misdiagnosis.

Before Replacing Parts

When troubleshooting a problem, check the following items for possible solutions
before replacing parts:

■ Verify that cables are connected properly to the suspected defective parts.

■ Verify that all required device drivers are installed.

■ Verify that all printer drivers have been installed.

Checklist for Solving Problems

If you encounter a minor problem with the computer or software applications, go
through the following checklist for possible solutions:

■ Is the computer connected to an external power source, or does it have a fully
charged battery pack installed?

■ Are all cables connected properly and securely?

■ Did the diskette drive contain a nonbootable diskette when you turned on the
computer?

■ Have you installed all the needed device drivers? For example, if you are using a
mouse, you may need to install a mouse device driver.

■ Are printer drivers installed?

Eliminating the typical problems described in this Troubleshooting section may save
you time and money. If the problem appears related to a software application, check the
documentation provided with the software. You may discover something you can
resolve easily by yourself.
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Solving Audio Problems

Table 2-15
Solving Audio Problems

Problem Probable Cause Recommended Action(s)

Computer does not beep after
the Power-On Self-Test
(POST).

Speaker volume has been
turned down.

Adjust the volume with the volume control
buttons located at the top right corner of the
computer.

Computer beeped five times
and battery light is blinking.

Computer has entered a
low-battery condition.

Immediately save open files and resolve the
low battery condition.

Computer does not beep to
indicate a low-battery
condition.

Low-battery warning beeps
have been turned off.

Enable low-battery warning beeps in
Windows 95 Power Properties or in
Computer Setup power management.

System beeps have been
turned down too low.

Press Fn+F5, then press the right arrow key
to increase the volume of the system beeps.

Audio playback is too low or
too loud.

The computer volume control
and/or the software volume
control needs to be adjusted.

In Windows 95, adjust the computer volume
control buttons and adjust the volume
control in Multimedia Properties.

NOTE: The volume control in Multimedia
Properties only affects the �Wave� audio
sources such as system sounds and *.wav
file playback. To change other sources such
as MIDI, video sound, and game effects, use
the Volume Control application in
accessories/Multimedia.

In Windows NT, adjust the multimedia
volume control under the Accessories
folder.

Internal speakers produce no
sound.

Volume has been muted. Press the increase volume control button to
increase the volume. Press Fn+F5, then
press the right arrow key to increase the
volume of the system beeps

External speakers or
headphones are connected to
the computer.

Use the external speakers or headphones or
use the Convenience Base II speakers.

To use the internal speakers, disconnect the
external speakers or headphones or undock
the computer.

Speaker wires are not
connected.

Make sure the speaker wires are connected
properly.

Speakers are bad. Replace the speakers.

Continued



2-20    Troubleshooting

Table 2-15  Continued

Problem Probable Cause Recommended Action(s)

Internal speaker does not
produce sound when an
external audio source is
connected to the stereo
line-in jack.

Volume may be turned off or
set too low.

■ Adjust the volume control located at
the top right corner of the computer.

■ Use the volume control and mixing
features available in Control Panel ⇒
Multimedia.

■ Adjust the volume using the speaker
icon on the taskbar.

Line input may not be
connected properly.

Check line input connection.

Headphones or speakers are
connected to the stereo
speaker/headphone jack,
which disables the internal
speakers.

Disconnect the headphones or speakers to
enable the internal speakers.

External microphone does
not work.

The wrong type of
microphone or microphone
plug is being used.

Check to see if a monophonic electret
condenser microphone with a 3.5-mm plug
is being used.

The microphone may not be
connected properly.

Ensure that the microphone plug is properly
connected to the mono microphone jack.

Sound source is not selected. Ensure that microphone is selected as the
recording source in Control Panel ⇒
Multimedia and that the recording level is
adjusted.

No sound from game
program.

Audio settings are not set
correctly.

Check the game program audio settings.

Computer volume control is
turned down.

Adjust the volume with the volume control
buttons located at the top right corner of
the computer.

Headphones are connected. Use or disconnect the headphones.

No sound from headphones. Volume or mixing controls set
incorrectly.

■ Adjust the volume with the volume
control buttons located at the top right
corner of the computer.

■ Use the volume control and mixing
features available in Control Panel ⇒
Multimedia.

Sound source not selected. Verify that the sound source is selected in
Control Panel ⇒ Multimedia.

Volume or mixing controls set
incorrectly.

■ Adjust the volume with the volume
control buttons located on the right
side of the computer.

■ Check the volume and mixer controls
in Control Panel ⇒ Multimedia.
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Solving Battery Problems

The following table lists some common battery problems and recommended actions to
take when they occur. The "Solving Power Problems" section in this chapter also may
be applicable.

Table 2-16
Solving Battery and Battery Gauge Problems

Problem Probable Cause Recommended Action(s)

The computer turns on the
first time it is used, but the
battery does not charge.

The battery pack is in
ship mode.

Remove and reinsert the battery pack.

Computer does not turn on
when battery pack is inserted
and power cord is unplugged.

Battery is discharged. Ensure that the battery  pack is
properly installed.

Connect the computer to an external power
source and charge the battery pack.

Replace the battery pack with a fully charged
battery pack.

Check battery status by pressing Fn+F8.

Computer beeped five times
and battery light is blinking.

Computer has entered a
low-battery condition.

Immediately save any open file(s). Then do
one of the following:

1. Connect the computer to an external
power source.

2. Turn the computer off and replace the
battery pack.

Computer battery light blinks
to indicate low battery
condition, but computer does
not beep.

Low battery beeps were
turned off.

Volume is turned off or turned
down too low.

Run Computer Setup and turn on the low
battery warning beeps.

Press Fn+F5 to adjust the volume of the
system warning beeps.

Battery light does not turn on
to indicate battery pack Is
charging.

Battery pack is already
charged.

Battery pack was exposed to
temperature extremes.

No action is necessary.

Allow time for the battery pack to return to
room temperature.

Battery pack is at the end of
its life.

Replace the battery pack.

Battery pack is warm to the
touch after charging.

Warming occurs during
charging.

No action is required.

Continued
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Table 2-16 Continued

Problem Probable Cause Recommended Action(s)

Computer turned off and
information in memory was
lost when the battery pack
was replaced.

Hibernation was disabled,
Suspend was not initiated, or
AC power was not connected
before the discharged battery
pack was removed.

To prevent loss of information next time,
initiate Suspend, enable Hibernation, or
connect AC power before changing
batteries..

You have to set the date and
time every time you turn on
the computer.

Real time clock (RTC) battery
is at the end of its life.

Replace the RTC battery.

Battery pack charge does not
last as long as expected.

Battery pack is being exposed
to high temperatures or
extremely cold temperatures.

Keep the battery pack within the
recommended operating temperature range
50°F to 104°F (10°C to 40°C) or
recommended storage range -4°F to 86°F
(-20°C to 30°C ). Recharge the battery
pack.

Battery pack has partially
self-discharged.

If the computer is disconnected from the
external power for more than two weeks,
remove the battery pack to reduce the self-
discharge rate.

Power management is
disabled.

Press Fn+F7 and set the power
conservation level.

An external device or PC Card
is draining the battery.

Turn off or disconnect external devices
when not using them.

Computer is beeping and
battery power light is blinking.

Battery pack charge is low. Do one of the following:

■ Charge the battery pack.

■ Replace the battery pack.

■ Connect the computer to an external
power source.

■ Initiate Hibernation.
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Solving CD-ROM Drive Problems

Table 2-17
Solving CD-ROM Drive Problems

Problem Probable Cause Recommended Action(s)

CD-ROM drive cannot read a
compact disc.

Compact disc is not properly
seated in the CD-ROM drive.

Open the CD loading tray, lay the compact
disc on it, then close the tray.

Compact disc is loaded in the
CD loading tray upside down.

Open the CD loading tray, turn over the
compact disc (label facing up), then close
the tray.

Compact disc has a scratch
on its surface.

Insert a different compact disc.

CD-ROM drive is not
recognized by the computer.

CD-ROM drive is not
connected properly.

Turn off the computer, remove the CD-ROM
drive and reinsert it.
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Solving Diskette and Diskette Drive Problems

Table 2-18
Solving Diskette and Diskette Drive Problems

Problem Probable Cause Recommended Action(s)

Diskette drive cannot read a
diskette.

Diskette media has a bad
sector.

Copy remaining files to the hard drive or
another formatted diskette. Reformat the
diskette.

Using the wrong diskette type
for the diskette drive type.

Use the required diskette type.

Diskette is not formatted. Format the diskette.

If you are using Windows 95:

1. From the Windows 95 desktop,
double-click My Computer.

2. Click 3 ½ Floppy (A:) ⇒ File ⇒ Format.

3. Fill in the appropriate information, then
click Start.

If you are using Windows NT, format the
diskette by entering format a: at the system
prompt.

Diskette drive cannot write to
a diskette.

Diskette is not formatted. Format the diskette.

If you are using Windows 95:

1. From the Windows 95 desktop,
double-click My Computer.

2. Click 3 ½ Floppy (A:) ⇒ File ⇒ Format.

3. Fill in the required information, then click
Start.

If you are using Windows NT, format the
diskette by entering format a: at the system
prompt.

Diskette is write-protected. Use another diskette that is not
write-protected or disable the write-protect
feature.

Writing to the wrong drive. Check the drive letter in your path
statement.

Not enough space is left on
the diskette.

Save the information to another diskette.

Disable diskette write ability
is turned on.

Run Computer Setup. Click on the Storage
icon. Make sure Disable diskette write
ability is not checked.
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Solving Hard Drive Problems

CAUTION:  To prevent loss of information, always maintain an up-to-date backup of the
hard drive.

Table 2-19
Solving Hard Drive Problems

Problem Probable Cause Recommended Action(s)

Cannot access hard drive. Hard drive is not seated. Shut down the computer, remove and
reinsert the hard drive, then turn on the
computer.

Hard drive was inserted while
computer was on, in Suspend,
or in Hibernation.

Shut down the computer, then turn it on
again to initialize it during power on.

Hard drive may be damaged. Try inserting another hard drive.

Reading hard drive takes an
unusually long time after
restarting the computer.

Hibernation was initiated and
system is now exiting from it.

Give the system time to restore the
previously saved data.

Hard drive error occurs. Hard drive has bad sectors or
has failed.

Do one of the following:

■ If you are running Windows 95, access
ScanDisk by clicking Start ⇒ Programs
⇒ Accessories ⇒ System Tools ⇒
ScanDisk, then check the Automatically
fix errors box. Click Start to begin
scanning.

If you are running Windows NT, go to
the system prompt and type chkdsk to
scan for errors.

■ Reformat the hard drive.

■ Contact your Compaq authorized dealer,
reseller, or service provider or Compaq
customer support for assistance.

Hard drive error occurs. Hard drive may be damaged. Try inserting another removable drive, if the
hard drive is in the MultiBay.

Errors occur after starting
from an additional hard
drive.

Additional hard drive does not
have the software and drivers
necessary to boot and operate
correctly.

Boot from the hard drive supplied with the
computer or another hard drive that has the
necessary software and drivers.

Hard drive does not work. Hard drive is not seated. Turn off and unplug the computer, remove
the hard drive, then reinsert it.
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Solving Hardware Installation Problems

Table 2-20
Solving Hardware Installation Problems

Problem Probable Cause Recommended Action(s)

New device is not
recognized as part of
the computer system.

The system did not
automatically configure the
new device.

In Windows 95, double-click the Add New
Hardware icon in Control Panel.

Refer to the documentation that came with
the new device for installation instructions.

Cable(s) of new external
device are loose or
power cables are
unplugged.

Ensure that all cables are properly and
securely connected and the power cord is
plugged into an electrical outlet.

Power switch of new
external device is not turned
on.

1. Turn off the computer.

2. Turn on the external device.

3. Turn on the computer to integrate the
device with the computer system.

New device is not
configured for Windows NT.

Use Computer Setup to view settings for
the new device or to reset the
configuration settings for preinstalled
devices.
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Solving Infrared Connection Problems

NOTE:  The computer is shipped with the infrared port disabled. The port must be
enabled each time the computer is started or restarted. Follow these steps to enable the
infrared port.

1. Click Start ⇒ Settings ⇒ Control Panel.
2. Double click the Infrared icon.
3. Select the Options tab.
4. Check the box labeled Enable Infrared Communications to select the Com3 port.
5. Click OK. The infrared icon appears on the task bar.

NOTE:  Windows NT does not support infrared communication.

Table 2-21
Solving Infrared Connection Problems

Problem Cause Recommended Action(s)

Cannot link with another
computer.

Interrupt request (IRQ) conflict Check IRQ assignments for conflicts and
reassign as necessary.

Baud rate conflict Select the same baud rate for both
computers.

# bits conflict Select the same �#bits� setting for both
computers.

Stop bit conflict Select the same stop byte for both
computers.

Parity conflict Select the same parity setting for both
computers.

Data transmission problem Direct sunlight, fluorescent
light, or flashing incandescent
light is close to the infrared
connections.

Remove the interfering light sources.

Interference from other
infrared devices

Keep remote control units and other
infrared devices away from the infrared
connections.

Physical obstruction Do not place objects between the two units
that will interfere with a line-of-sight data
transmission.

Movement Do not move either unit during data
transmission.

Orientation Adjust devices so that they point within 30
degrees of each other.

Distance Verify that devices are not more than 3 feet
(1 meter) apart.

Cannot connect at 4 MB/sec Fast IR driver not installed Fast-IR is not preinstalled. Download FAST-
IR driver from Compaq web site and install.
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Solving Modem Problems

Table 2-22
Solving Modem Problems

Problem Probable Cause Recommended Action(s)

Modem loses connection. The connection from the
phone line to the modem is
loose.

Check to make sure the telephone cable is
properly connected.

Call Waiting has not been
disabled.

Disable Call Waiting.

1. Click Start ⇒ Control Panel ⇒
double-click Modems.

2. From the General tab of the Modems
Properties page, click Dialing Properties.

3. From the My Locations tab of the Dialing
Properties page, check the box labeled
This location has call waiting. Select
*70, 70#, or 1170 from the drop-down list
to disable call waiting for your dialing
area.

Noisy telephone line Phone line noise causing
garbled or missing
characters, or slow data
transfer speeds.

Check your telephone and modem cable
connections. If they are a little loose, they
can cause noise on the line.

Check with your local telephone company for
a phone line filter.

Phone line noise causing a
disconnection.

Hang-up Delay S Register
(S10) set too low.

Change S10 default to 150.

1. Click Start ⇒ Programs ⇒
Accessories ⇒ HyperTerminal.

2. Go to Command Mode.

3. Type ATS10=150 and press Enter.

This command causes the modem to take
longer to disconnect even if there is noise
on the line.

Continued
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Table 2-22 Continued

Problem Probable Cause Recommended Action(s)

No dial tone Phone service is not
connected to the telephone
wall jack.

Verify service from the local phone
company:

1. Unplug the telephone cable from the
telephone wall jack.

2. Connect a telephone to the jack, pick up
the handset, and listen for a dial tone. If
there is a dial tone, reconnect the
modem to the telephone wall jack with
the telephone cable and make sure all
connections are secure.

3. If there is still no dial tone, contact your
local phone company or building
manager.

The modem is not responding
to commands from the
computer keyboard.

Verify the modem and computer are
connected:

1. Click Start ⇒ Programs ⇒
Accessories ⇒ HyperTerminal.

2. Go to Terminal Mode, then type AT and
press the Enter key.

If the modem displays OK, the modem
and computer are working together. If
the modem displays ERROR, or does not
respond, restart the computer and repeat
step 1.

3. Type ATDT and listen for a dial tone.

4. Type ATH0 (zero) to hang up.

Speaker Control AT Command
(ATM) is set to 0.

Set the Speaker Control to 1:

1. Click Start ⇒ Programs ⇒
Accessories ⇒ HyperTerminal.

2. Go to Command Mode, type ATM1 and
press Enter.

3. Type ATH1 and listen for a dial tone.

4. Type ATH0 (zero) to hang up.

The modem is plugged into a
digital PBX line rather than an
analog line.

Plug the modem into an analog line. If you
are in an office, the analog line is often the
one connected to a fax machine or modem.
To get an analog line in a hotel, request a
room with a �data� line.

Characters are garbled and
transfer rates are slow.

There is noise in the
telephone line.

■ Check your telephone and modem
cable connections. If they are loose,
they can cause noise on the line.

■ Check with your local telephone
company for a phone line filter.

Continued
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Table 2-22 Continued

Problem Probable Cause Recommended Action(s)

Phone line noise causes a
disconnection.

Hang-Up Delay S Register
(S10) set too low.

Change S10 default to 150.

1. Click Start ⇒ Programs ⇒
Accessories ⇒ HyperTerminal.

2. Go to Command Mode.

3. Type ATS10=150 and press Enter.

This command causes the modem to take
longer to disconnect even if there is noise
on the line.

Ten-digit dialing does not
work correctly under Windows
95.

Ten-digit dialing doesn�t work
correctly under Windows 95,
making it difficult to dial
numbers in a different area
code that are not long
distance calls.

Since Windows 95 does not limit the number
of digits you can enter in the Phone Number
field, set the Area Code field to match your
local area code. Then type the ten-digit
telephone number in the Phone Number
field.

Modem cable
disables/interferes with other
telephony devices (Germany,
Austria, and Switzerland only).

The modem cable does not
provide the additional 4-wire
connection required in
Germany, Austria, and
Switzerland to form the serial
pass-through necessary so
that other devices can work
on the same phone line.

To use another telephony device on the
same line in these countries, unplug the
modem cable from the wall jack first.

Modem does not dial correctly
under Windows 95
(Switzerland and Germany
only).

The “Wait for dial tone before
dialing”  check box is checked.
This causes Windows 95 to
issue an ATDT; command. A
typical dial string would look
like this:

ATDT;

ATDTnnn-nnnn

In Germany and Switzerland,
the ‘ ;’  dial modifier is not
permitted to be used in this
fashion by regulatory agencies
since ATDT; takes the modem
off-hook without dialing.
Therefore, the modem returns
an error message when
attempting to dial. The error
message reads:

�The computer is not
receiving a response from the
modem. Check that the
modem is plugged in, and if
necessary, turn the modem
off, then turn it back on.�

1. Click Start ⇒ Settings ⇒ Control Panel.

2. Double-click the Modems icon.

3. Click the Properties button.

4. Select the Connection tab.

5. Click the “Wait for dial tone before
dialing”  check box to clear it.

6. Click OK ⇒ Close.
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Solving PC Card Problems

Table 2-23
Solving PC Card Problems

Problem Probable Cause Recommended Action(s)

Computer does not beep
when PC Card is inserted but
PC Card works correctly.

System beeps are turned
down.

PC Card sound effects have
been disabled.

Press Fn+F5, then press the right arrow
key to increase the system beeps volume.

In Windows 95, double-click PC Card icon ⇒
Global Settings tab. Deselect Disable PC
Card Sound Effects.

Computer does not beep when
PC Card is inserted and PC
Card does not work.

PC Card is not inserted
properly.

The PC Card slots have been
disabled.

Remove and reinsert the card gently to
avoid damaging the pins.

Run Computer Setup to enable the PC Card
slots. When the system starts, press F10 then
select Computer Setup ⇒ Other Devices ⇒
PC Card Controller ⇒ Resources. Deselect
the �Disabled� check box.

In Windows 95, click Start ⇒ Settings ⇒
Control Panel ⇒ System ⇒ Device
Manager ⇒ PCMCIA Socket. Double-click
the Texas Instruments TI-1131 CardBus
controller to view device properties.
Deselect the �Disable in this hardware
profile� check box.

Card or card driver is not
compatible with the computer
or with the operating system.

Contact service provider for a list of
compatible PC Cards.

Computer beeps twice, but
modem and/or fax does not
work.

Telephone cord is not plugged
in all the way.

Verify that the telephone connection is
secure.

The wrong COM port is being
used to access the card.

Verify the COM port assigned to the card and
within the application is correct.

In Windows 95, click Start ⇒ Help ⇒
Contents ⇒ Troubleshooting ⇒ Problem.
Follow the instructions on the screen.

Computer beeps twice but
network card does not work.

Network server is
unavailable.

Contact system administrator.

Computer beeps twice when
a storage card is inserted, but
the card does not work.

The wrong drive letter is
being used to access the
storage card.

Open Windows Explorer and verify the drive
letter.

PC Card does not work Windows NT was running
when the PC Card was
inserted.

Turn off the computer and reinsert the PC
Card.
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Solving Power Problems

Table 2-24
Solving Power Problems

Problem Probable Cause Recommended Action(s)

Computer will not turn on. Computer is not connected to
a power source.

Insert battery pack or connect an external
power source.

Power cord to the external
power source is unplugged.

Ensure that power cord connecting the
computer and the external power source is
plugged in properly.

Battery pack is discharged. Insert a fully charged battery pack or
connect an external power source.

CMOS data is corrupt Flush CMOS memory. See note on page 11.

Computer will not turn on
when connected to external
power if battery pack is in
the computer.

Battery pack may be
defective.

Remove battery pack, insert another battery
pack, and try again.

Computer turned off while it
was left unattended and the
power/suspend light is off.

System initiated Hibernation
after a preset timeout.

Turn on the computer to restore information
at the point where Hibernation was
initiated.

NOTE: To change the Hibernation timeout
setting in Windows 95, click the
Hibernation tab in Power Properties. In
Windows NT, run Computer Setup and
select Power Management.

Computer turned off while it
was left unattended and will
not turn on.

System initiated Hibernation
and/or shut down because of
a critical low-battery
condition.

Replace the battery pack with a fully
charged battery pack or connect an
external power source, then turn on the
computer.

Computer initiated Suspend
or turned off when it was
docked.

The maximum operating
temperature was exceeded.

Computer is in a high temperature
environment and the fan is not able to cool
it. Let the computer cool down and turn it
on again.

Make sure the ventilation intake and
exhaust are not obstructed.

Hibernation does not work
properly.

Hibernation was not reset
after a memory upgrade.

Reset Hibernation in the Power
Management utility.

Computer does not turn on
when connected to external
power and no batteries are
installed.

Internal power supply is bad. Replace the internal power supply.
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Solving Screen Problems

IMPORTANT:  Conduct all tests on a working monitor. If the recommended actions do
not solve the problem, replace the display. If the problem persists with a new display,
replace the system board.

Table 2-25
Solving Screen Problems

Problem Probable Cause Recommended Action(s)

Characters are dim. The brightness or contrast
control (if applicable) is not
set properly.

Adjust the control(s) with the hotkeys:
Fn+F9 and Fn+F10.

Computer screen is in direct
light.

Tilt the display or move computer.

Display is damaged. Replace the display.

Screen is blank. QuickLock/QuickBlank was
initiated.

Enter the password to exit
QuickLock/QuickBlank.

Screen save was
initiated after the Power
Management timeout period.

Press any key or click the mouse.

Brightness or contrast needs
adjusting.

Adjust the control(s) with the hotkeys:
Fn+F9 and Fn+F10.

Screen has overheated. If computer is in direct sunlight, move it
and allow it to cool.

Computer screen is
blank and the screen on an
external monitor displays
information.

Display was switched to the
external monitor.

Press the Fn+F4 hotkeys to display
information on the computer screen.

Screen is blank and the
power/suspend light is
blinking.

System initiated Suspend. Press the suspend button to exit Suspend.
Enter the power-on password if prompted.

Screen is blank and the
power/suspend light and the
battery light are blinking.

System has entered a critical
low-battery condition.

Immediately connect the computer to an
external power source or replace the
battery pack.

Continued



2-34    Troubleshooting

Table 2-25 Continued

Problem Probable Cause Recommended Action(s)

External monitor does not
display information.

External monitor was
connected after the computer
was turned on.

Press the Fn+F4 hotkeys to switch to the
external monitor.

The external monitor signal
cable or power cord is not
properly connected.

Ensure that the cables are properly
connected.

Small red, green, or blue
spots appear on the
computer CTFT display.

Small spots, called on-pixels,
often appear on CTFT
screens. Compaq limits the
number of these on-pixels to
0.003 percent.

No action is required.

Display on an external
monitor is distorted.

Incorrect display device
drivers are installed or
incorrect resolution is set.

Double-click the Display icon in Control
Panel, click the Settings tab, and set the
correct display type and resolution for the
external monitor.

The external monitor is not
Energy Star compliant, but
monitor energy saving
feature is enabled.

Complete these steps:

1. Press any key or move the pointing
device to restore the display.

2. If display remains distorted, turn off the
monitor, then turn it on again.

3. Disable the monitor energy saving
feature in Display Properties or in
Computer Setup Power Management.

The image has a black
border and does not fill the
screen.

The Desktop Area setting is
smaller than the Resolution
setting.

Adjust the settings for the Desktop Area and
Resolution. Double-click Control Panel
Display ⇒ Settings ⇒ Compaq.

Press the Fn+T keys to expand the image.
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Solving USB Problems

Table 2-26
Solving USB Problems

Problem Probable Cause Recommended Action(s)

External device connected to
a USB connector does
not work.

The operating system limits
external devices connected
by USB to two tiers that can
include no more than two
hubs on the first tier and no
more than one keyboard and
one pointing device on the
first or second tier.

Reduce the number of connected external
USB devices to no more than two hubs on
the first tier, and no more than one keyboard
and one pointing device on the first or
second tier.

External device connected to a
USB connector does not work
during startup (before
Windows 95 loads).

During startup, only two tiers
are supported by the USB
connector. These tiers can
include no more than two
hubs on the first tier and no
more than one keyboard and
one pointing device on the
first or second tier.

■ Use the external device only after
Windows 95 has loaded.

■ Reduce the number of connected
external USB devices to no more than
two hubs on the first tier, and no more
than one keyboard and one pointing
device on the first or second tier.

External devices in lower
tiers do not work.

An unpowered hub is
connected to another
unpowered hub.

■ Use only powered hubs.

■ Make sure that all unpowered hubs are
immediately preceded by powered
hubs in the USB chain.
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chapter
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ILLUSTRATED PARTS CATALOG

This chapter provides illustrated parts and references for spare parts for the Compaq
Armada 1700 Family of Personal Computers. To review an illustrated parts breakdown
of the computer, refer to the Illustrated Parts Map that comes with this guide.
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3.1  System Unit

Figure 3-1. System Unit
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Table 3-1
System Unit

Item Description Spares Part Number

1 Keyboard  (US/Canada) 316227-001

* Keyboard (Belgian) 316227-181

* Keyboard (Brazilian) 316227-201

* Keyboard (Danish) 316227-081

* Keyboard (French Canadian) 316227-121

* Keyboard (French) 316227-051

* Keyboard (German) 316227-041

* Keyboard (Hangeul) 316227-AD1

* Keyboard (Italian) 316227-061

* Keyboard (Japanese) 316227-291

* Keyboard (Latin American Spanish) 316227-161

* Keyboard (Norwegian) 316227-091

* Keyboard (Portuguese) 316227-131

* Keyboard (Spanish) 316227-071

* Keyboard (Swiss) 316227-111

* Keyboard (Taiwanese) 316227-AB1

* Keyboard (UK English) 316227-031

2 Top cover assembly 316280-001

3 Base enclosure assembly 316281-001

4 12.1-inch CTFT display assembly 316275-001

* 13.3-inch CTFT display assembly 316277-001

 * Not illustrated
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3.2  Mass Storage Devices

Figure 3-2. Mass Storage Devices

Table 3-2
Mass Storage Devices

Item Description Spares Part Number

1 24x CD-ROM drive 316267-001

* DVD-ROM drive module 316295-001

2 4.0-GB hard drive 255292-001

3 1.44-MB, diskette drive 316266-001

4 LS-120 drive module 316293-001

5 100-MB ZIP drive module 316288-001

*  Not illustrated
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3.3  Cables and Power Cords

Figure 3-3. Cables and Power Cords

Table 3-3
Cables and Power Cords

Item Description Spares Part Number

1 AC power cord  (US/Canada) 255135-001

* AC power cord (Australia/New Zealand) 255135-011

* AC power cord (China) 255135-AA1

* AC power cord (Denmark) 255135-081

* AC power cord (Europe) 255135-021

* AC power cord (Italy) 255135-061

* AC power cord (Japan) 255135-291

* AC power cord (Korea) 255135-AD1

* AC power cord (Singapore) 255135-111

* AC power cord (UK) 255135-031

2 Modem cable  (included in optional modem kit)

3 RTC battery 316284-001 (included in shielding kit)

*  Not illustrated
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3.4  Standard and Optional Boards

Figure 3-4. Standard and Optional Boards

Table 3-4
Standard and Optional Boards

Item Description Spares Part Number

1 Memory board (SODIMM), 16-MB, 60 ns, nonparity 313917-001

* Memory board (SODIMM), 32-MB, 60 ns, non parity 313911-001

* Memory board (SODIMM), 64-MB, 60 ns, non parity 313918-001

* Memory board (SODIMM), 128-MB, 60 ns, non parity 310345-001

2 Audio/LED board 316260-001

3 DC-DC voltage converter 316264-001

4 System board with 233-MHz Intel Pentium II CPU 316261-001

* System board with 266-MHz Intel Pentium II CPU 316262-001

5 K56flex modem 316279-001

6 IR module 316313-001

*  Not illustrated
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3.5  Options

Figure 3-5. Options

Table 3-5
Options

Item Description Spares Part Number

1 Automobile/Aircraft adapter 313919-001

2 External battery charger 254970-001

3 Li-ion battery pack 316231-001

4 Hard drive adapter 316294-001

* Convenience Base II - pass through 316291-001

* Convenience Base II - Ethernet 316312-001

* Monitor stand 316286-001

*  Not illustrated
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3.6  Miscellaneous Parts

Figure 3-6. Miscellaneous Parts

Table 3-6
Miscellaneous Parts

Item Description Spares Part Number

1
2
3
4
5

Miscellaneous Plastics kit :

Left clutch/display wiring cover
Right clutch/microphone cover
RTC battery cover
Hard drive cover
Modem cover

316282-001

6 Fan 316271-001

7 Internal AC adapter 316265-001

* Screw kit 316283-001

* Shielding kit (includes RTC battery) 316284-001

* Logo kit 316287-001

* Country kit (N.A.) 316285-001

* Country kit (Europe) 316285-002

*  Not illustrated
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3.7  Documentation

Table 3-7
Documentation

Description Spare Part Number

Illustrated Parts Map 316268-001

Maintenance and Service Guide 316272-001
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chapter
 4

REMOVAL AND REPLACEMENT

PRELIMINARIES

This chapter provides essential information for proper and safe removal and
replacement service.

4.1  Tools Required

You will need the following tools to complete the removal and replacement procedures:

■ Magnetic Torx T-8 screwdriver (for all screws unless otherwise specified)

■ 7-mm hex socket (for bushing guides)

■ Tool kit, Compaq part number 100767-001 (includes connector removal tool,
loopback plugs, and case utility tool)

■ Small flat-blade screwdriver (optional)

■ Scribe

■ Tweezers

4.2  Service Considerations

Listed below are some of the considerations that you should keep in mind during
disassembly and assembly procedures.

Plastic Parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

IMPORTANT: As you remove each subassembly from the computer, place it (and all
accompanying screws) away from the work area to prevent damage.
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Cables and Connectors

Cables must be handled with extreme care to avoid damage. Apply only the tension
required to unseat or seat the cables during removal and insertion. Handle cables by the
connector whenever possible. In all cases, avoid bending, twisting, or tearing cables.
Ensure that cables are routed in such a way that they cannot be caught or snagged by
parts being removed or replaced. Handle flex cables with extreme care; they tear easily.

CAUTION: When servicing the computer, ensure that cables are placed in their
proper location during the reassembly process. Improper cable placement can
damage the computer.

4.3  Preventing Damage to Removable Drives

Removable drives are fragile components that must be handled with care. To prevent
damage to the computer, damage to a removable drive, or loss of information, observe
these precautions:

■ Before removing or inserting a hard drive, shut down the computer. If you are unsure
whether the computer is off or in Hibernation, turn the computer on, then shut it
down.

■ Before removing a diskette drive or CD-ROM drive, ensure that a diskette or disc is
not in the drive. Ensure that the CD-ROM tray is closed.

■ Before handling a drive, ensure that you are discharged of static electricity. While
handling a drive, avoid touching the connector.

■ Handle drives on surfaces that have at least one inch of shock-proof foam.

■ Avoid dropping drives from any height onto any surface.

■ Always place MultiBay drives in the carrying case when removed from the
computer.

■ Do not use excessive force when inserting a drive into the MultiBay.

■ Avoid exposing a hard drive to products that have magnetic fields such as monitors
or speakers.

■ Avoid exposing a drive to temperature extremes or to liquids.

■ If a drive must be mailed, do the following:

– Place the hard drive into a bubble pack mailer or other suitable form of protective
packaging.

– Label the package “Fragile: Handle With Care.”
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4.4  Preventing Electrostatic Damage

Many electronic components are sensitive to electrostatic discharge (ESD). Circuitry
design and structure determine the degree of sensitivity. Networks built into many
integrated circuits provide some protection, but in many cases the discharge contains
enough power to alter device parameters or melt silicon junctions.

A sudden discharge of static electricity from a finger or other conductor can destroy
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but
damage occurs. An electronic device exposed to electrostatic discharge may not be
affected at all and can work perfectly throughout a normal cycle. Or it may function
normally for a while, then degrade in the internal layers, reducing its life expectancy.

Packaging and Transporting Precautions

Use the following grounding precautions when packaging and transporting equipment:

■ To avoid hand contact, transport products in static-safe containers such as tubes,
bags, or boxes.

■ Protect all electrostatic-sensitive parts and assemblies with conductive or approved
containers or packaging.

■ Keep electrostatic-sensitive parts in their containers until they arrive at static-free
workstations.

■ Place items on a grounded surface before removing them from their container.

■ Always be properly grounded when touching a sensitive component or assembly.

■ Place reusable electrostatic-sensitive parts from assemblies in protective packaging
or non-conductive foam.

■ Use transporters and conveyers made of antistatic belts and roller bushings. Ensure
that mechanized equipment used for moving materials is wired to ground, and that
proper materials were selected to avoid static charging. When grounding is not
possible, use an ionizer to dissipate electric charges.
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Workstation Precautions

Use the following grounding precautions at workstations:

■ Cover the workstation with approved static-dissipative material (refer to Table 4-2
later in this chapter).

■ Use a wrist strap connected to a properly grounded work surface and use properly
grounded tools and equipment.

■ Use field service tools, such as cutters, screwdrivers, and vacuums that are
conductive.

■ When using fixtures that must directly contact dissipative surfaces, use fixtures made
of static-safe materials only.

■ Keep work area free of nonconductive materials such as ordinary plastic assembly
aids and Styrofoam.

■ Handle electrostatic-sensitive components, parts, and assemblies by the case or PCM
laminate. Handle them only at static-free workstations.

■ Avoid contact with pins, leads, or circuitry.

■ Turn off power and input signals before inserting or removing connectors or test
equipment.
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Grounding Equipment and Methods

Grounding equipment must include either a wrist strap or a foot strap at a grounded
workstation.

■ When seated, wear a wrist strap connected to a grounded system. Wrist straps are
flexible straps with a minimum of one megohm ±10% resistance in the ground cords.
To provide proper ground, a strap must be worn snug against the skin. On grounded
mats with banana-plug connectors, connect a wrist strap with alligator clips.

■ When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or
boot straps) can be used at standing workstations and are compatible with most types
of shoes or boots. On conductive floors or dissipative floor mats, use them on both
feet with a minimum of one-megohm resistance between the operator and ground. To
be effective, the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing electrostatic damage
include:

■ Antistatic tape

■ Antistatic smocks, aprons, or sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Non-conductive foam

■ Conductive tabletop workstations with ground cord of one-megohm resistance

■ Static-dissipative table or floor mats with hard tie to ground

■ Field service kits

■ Static awareness labels

■ Material-handling packages

■ Non-conductive plastic bags, tubes, or boxes

■ Metal tote boxes
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Electrostatic Voltage Levels and Protective Materials

Table 4-1 shows how humidity affects the electrostatic voltage levels generated by
different activities.

Table 4-1
Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V  5,000 V 3,000 V

Motions of bench worker  6,000 V    800 V   400 V

Removing DIPS from plastic tube  2,000 V    700 V   400 V

Removing DIPS from vinyl tray 11,500 V  4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V  5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

NOTE: 700 volts can degrade a product.

Table 4-2 lists the shielding protection provided by antistatic bags and floor mats.

Table 4-2
Static-Shielding Materials

Material Use Voltage Protection Level

Antistatic plastic Bags  1,500 V

Carbon-loaded plastic Floor mats  7,500 V

Metallized laminate Floor mats 15,000 V
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chapter
 5

REMOVAL AND REPLACEMENT

PROCEDURES

This chapter provides the removal and replacement procedures for the computer
subassemblies.

5.1  Serial Number

The computer serial number should be provided to Compaq support when requesting
information or ordering spare parts. The serial number 1 is located on the back of the
computer (Figure 5-1).

Figure 5-1. Serial Number Location
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5.2  Disassembly Sequence

Refer to the disassembly steps before disassembling the computer. Disassemble only the
components necessary to gain access to the sub-assembly you are servicing.

5.3  Preparing the Computer for Disassembly

Disconnecting the AC Power

Battery

MultiBay Devices

PCMCIA

5.4 Computer Tilt Feet

5.5  Internal Modem

IR (Infrared) Module

5.6  Hard Drive

5.7  Keyboard

Memory Board

Lithium Real Time Clock Battery

Optical Disc Bay

5.8 Display Assembly

Hinge Covers

Display Assembly

5.9  Top Cover Assembly

DC-DC Converter

Audio Board

Fan

System Board

Integrated AC Adapter
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5.3  Preparing the Computer for Disassembly

Before beginning the removal and replacement procedures, complete the following:

1. Disconnect the modem line cord.

2. Disconnect the AC power and any external devices.

3. Remove the battery pack(s).

4. Remove the MultiBay device.

5. Remove any PC Cards.

! WARNING:  To reduce the risk of personal injury from hot surfaces, allow the internal
system components to cool before touching.

Disconnecting the AC Power

Before beginning service procedures on the computer, remove all power from the
system to prevent damage to the equipment or personal injury. Select the appropriate
steps, depending on whether the computer is docked or not.

Computer is Docked

If the computer is docked in the convenience base, it must be undocked before
performing additional work. Complete the following steps to undock the computer.

1. Close all applications and exit the operating system.

2. Turn off the computer.

3. Disconnect the AC power and any external cables.

4. Close the computer.

5. Pull the docking lever forward to undock the computer.

6. Lift the computer from the convenience base.

7. Remove the battery pack.

Computer is Not Docked

If the computer is not docked, perform the following steps:

1. Close all applications and exit the operating system.

2. Turn off the computer.

3. Turn off and disconnect any external devices.

4. Disconnect the AC power cord from the power source.

5. Disconnect the AC power cord from the computer.

6. Remove the battery pack.
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Battery Pack Removal

Remove the battery pack before beginning any internal maintenance on the computer.

! WARNING:  Metal objects can damage the battery pack as well as the battery contacts
in the battery compartment. To prevent damage, do not allow metal objects to touch the
battery contacts. Place only the battery pack for the Compaq Armada Personal Computer
into the battery compartment. Do not force the battery pack into the bay.

! WARNING:  Do not crush, puncture, or incinerate the battery pack. Do not dispose of in
water. Do not expose to temperatures higher than 60°C. Do not open a battery pack, as
this damages the pack, makes it unserviceable, and exposes potentially harmful battery
components. There are no field-serviceable parts located inside the battery pack.

To remove the battery pack from the computer, complete the following steps:

1 Slide the battery release latch 1.

2 Remove the battery pack.

Figure 5-2. Removing the Battery Pack

CAUTION:  Installing the battery pack upside down can cause the contacts to break.
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MultiBay Devices

CAUTION:   The device in the MultiBay must be removed prior to performing
maintenance on the computer.

A diskette drive, an LS-120 diskette drive, a ZIP drive, a second battery pack, or a
second hard drive may be installed into the MultiBay.

The device in the MultiBay must be removed prior to performing maintenance on the
computer. For convenience, a diskette drive is depicted in this sequence. To remove any
MultiBay device, complete the following steps:

1. If applicable, remove the security screw from the bottom side of the computer (LS-
120 drive and ZIP drive only).

2. Press down on the release latch 1 and grasp the tab located on the underside of the
device.

3. Remove the device.

Figure 5-3. Removing the MultiBay Device
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PCMCIA

Remove any installed PC (PCMCIA) Cards before performing any service on the
computer. To remove a PC Card, complete the following steps:

1. To release the PC Card eject button, depress the button once 1,2.

2. To eject the PC Card, firmly depress the PC Card eject button a second time.

3. Remove the card.

Figure 5-4. Removing the PC Card
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5.4 Computer Tilt Feet

There are two tilt feet on the bottom of the computer. To remove a foot, follow the steps
listed.

1. Turn the computer bottom side up and position it so that the front of the unit is
toward you.

2. Open the foot to the fully extended position.

3. Place a flat-blade screwdriver between the right hinge point of the foot and the unit.
The tip of the blade must be under one end of the foot, immediately below the hinge
point. Be careful not to mar or scratch the plastic base enclosure.

4. Press the foot toward the closed position, and simultaneously press down the handle
of the screwdriver toward the table. The foot will snap out of the hinges.

Figure 5-5. Removing the Computer Tilt Feet

To replace the foot, place the left end of the hinge on the hinge point. Rotate the right
end of the hinge into position over the right hinge point and press firmly. The hinge will
snap into place with moderate pressure.
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5.5  Internal Modem

The internal modem is standard on some models and is attainable as an upgrade option
on other models. If the model is not equipped with a modem, the modem compartment
is sealed by a protective plate underneath the modem cover.

For models equipped with a modem, complete the following steps to remove the
modem.

1. Prepare the computer for disassembly (Page 5-3).

2. Turn the computer bottom side up with the front of the unit toward you.

3. Remove the screw from the modem access cover.

4. Remove the modem access cover.

Figure 5-6. Removing the Modem Access Cover
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5. Remove the modem board retaining screw.

6. Carefully pull the modem board release tab and lift the modem from the computer.

Figure 5-7. Removing the Modem Board

To replace or install the modem, reverse the procedure.

NOTE:  When installing the modem, be sure that the modem release tab is folded on top
of the modem before replacing the modem access door.
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IR (Infrared) Module

To remove the Infrared (IR) transceiver module:

1. Prepare the computer for disassembly (Page 5-3).

2. Remove the modem (Page 5-7).

3. Remove the screw from the IR module

4. Disengage the connector from the system board by lifting the corner of the IR
module with a screwdriver.

5. Lift the IR module from the base enclosure.

Figure 5-8. Removing the IR Module

To install the IR module, reverse the procedure above.

NOTE:  If you are replacing the base enclosure, transfer the IR module to the new
enclosure.
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5.6  Hard Drive

The hard drive is held in place with a security screw and a retaining bracket. To remove
the hard drive, complete the following steps:

1. Prepare the computer for disassembly (Page 5-3).

2. Turn the computer bottom side up and position it so that the front of the unit is
toward you.

3. Remove the security screw from the drive cover.

Figure 5-9. Removing the Hard Drive Cover Security Screw
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4. Slide the release latch toward the back of the computer. The cover lid springs open

5. Slide the hard drive cover toward the front of the computer

6. Lift the cover from the computer.

Figure 5-10.  Removing the Hard Drive Cover
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7. Disengage the hard drive from the connector by sliding the hard drive toward the
front of the computer.

8. Using the lifting tab, remove the hard drive from the computer.

Figure 5-11. Removing the Hard Drive

Reverse the above procedure to install the hard drive. Be sure to place the lifting tab
inside the computer before replacing the cover.
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5.7  Keyboard

To release the keyboard, complete the following procedures.

1. Prepare the computer for disassembly (Page 5-3).

2. Place the computer on the workspace with the front of the unit facing you.

3. Open the display to the vertical position.

4. To release the keyboard, insert the tip of the scribe into each of the keyboard holes,
and pull the free end of the scribe towards you.

5. Slide the keyboard toward you. Be careful not to stress the keyboard cable.

Figure 5-12. Releasing the Keyboard Latches
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6. Lift the keyboard.

7. Place the keyboard in an upright position. Insert the two tabs on the right side and the
tab on the left side of the keyboard into the slots provided on the right of the base
enclosure.

Figure 5-13. Placing the Keyboard Tabs into the Slots in the Base

It is not necessary to completely remove the keyboard from the base enclosure to do the
following service procedures:

■ Memory expansion board installation, replacement, or upgrade.

■ Lithium real-time clock battery replacement.

■ Optical disc bay replacement or upgrade.

If you need to separate the keyboard from the system base enclosure, refer to the
keyboard removal section.
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Keyboard Removal

1. Release the latch on the keyboard ZIF connector.

2. Slide the strain relief on the flat cable toward the back of the computer, then lift the
front edge of the strain relief from the recess.

3. Disconnect the keyboard ribbon cable.

4. Remove the keyboard from the computer.

Figure 5-14.  Disconnecting the keyboard Ribbon Cable

To replace the keyboard, reverse the procedure above.

NOTE:  To replace the strain relief, place the edge of the strain relief nearest the back of
the computer down into the recess, press the strain relief toward the rear of the computer
and rotate the front edge down toward the computer.
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Memory Board

If a memory expansion board option has been previously installed in the computer, it
must be removed before another is installed. To remove the memory board, complete
the following steps:

1. Prepare the computer for disassembly (Page 5-3).

2. Lift the the keyboard as described (Page 5-14).

3. Position the keyboard upright by placing the keyboard tabs on the keyboard in the
slots provided.

4. Pull out the right and left locking tabs on each end of the memory expansion board.
This releases the memory board and allows it to rotate upward to ease removal.

CAUTION:  If you need to remove the memory expansion board, be sure to release the
locking tabs that secure the memory board in the slot. If the tabs are not released, the
connectors may break and cause irreparable damage to the system board.

Figure 5-15. Releasing the Memory Expansion Board
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5. Rotate the free edge 1 of the memory module upward.

6. At a 45 degree angle, pull the memory module 2 from the slot.

Figure 5-16. Removing the Memory Expansion Board
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To install a memory board, complete the following steps:

1. Insert the memory board 1 into the memory slot.

2. Pivot the memory board toward the computer 2 so that it lays flat in the memory
compartment.

3. Insert the memory board firmly into place to seat the connections and to engage the
locking tabs.

Figure 5-17. Installing the Memory Board
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Lithium Real Time Clock Battery

! WARNING:  There is a risk of explosion and injury if the battery is incorrectly replaced or
handled improperly. Do not attempt to  recharge, disassemble, immerse in water, or
dispose of it in fire. Replacement should be done using the Compaq spare part for this
computer.

To remove the Lithium Real Time clock (RTC) battery, complete the following steps:

1. Prepare the computer for disassembly (Page 5-3).

2. Raise the keyboard (Page 5-14).

3. Place the tabs on the keyboard in the slots provided in the top cover.

4. Press the retaining clip 1 toward the center of the computer.

5. Lift the battery cover 2 from the computer.

Figure 5-18. Removing the RTC Battery Cover
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CAUTION:  To prevent damaging the RTC battery cable, do not pull on the battery cable.

6. Using tweezers, disconnect the RTC battery connector from the system board.

7. Remove the RTC battery.

Figure 5-19. Removing the RTC Battery

Reverse the procedure to install a replacement RTC battery.
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Optical Disc Bay

A CD-ROM or DVD-ROM drive can be installed in the optical disc bay. To remove a
CD-ROM drive or DVD-ROM drive, complete the following steps:

1. Prepare the computer for disassembly (Page 5-3).

2. Remove the keyboard (Page 5-14).

Note:  For clarity, the keyboard is shown removed from the computer. The keyboard
may be left attached to the system unit for this procedure.

3. Place the tabs on the keyboard in the slots provided in the top cover.

4. Remove the two retaining 1 screws.

5. Reach into the access opening 2 with a finger and push the drive toward the front of
the computer.

6. Remove the optical disc bay drive.

Figure 5-20. Removing the Optical Bay Drive

To install a CD-ROM drive or DVD-ROM drive, reverse the procedure.
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5.8 Display Assembly

To remove the display assembly, complete the following steps:

Hinge Covers

1. Prepare the computer for disassembly (Page 5-3).

2. Close the cover and place the computer on the workspace top side up and position it
so that the connectors on the back panel of the computer are facing you.

3. Remove the screw from each of the hinge covers.

Figure 5-21. Removing the Hinge Cover Screws
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4. Open the display fully.

5. Lift the hinge covers from the computer. Note that the right and left covers are
different.

Figure 5-22. Removing the Hinge Covers

Reverse the procedure to install the hinge covers.
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Display Assembly

CAUTION:  Do not reuse the hinge screws removed from the previously installed display.
These screws may back out of the display hinges and cause the display assembly to
loosen from the base enclosure.

Important:  It is not necessary to separate the display and the top cover unless you are
replacing the display or the top cover. If you are not replacing the top cover or the
display assembly, complete steps 1 through 4 to remove the top cover/display assembly
from the base.

To remove the display assembly, complete the following procedure:

1. Prepare the computer for disassembly (Page 5-3).

2. Remove the hinge covers (Page 5-23).

3. Remove the screw 1 holding the ground lugs to the left hinge clutch.

4. Separate the backlight power cable 2 and the display data cable 3 from the system
board. Use a small flat-tipped screwdriver or other instrument to lift the connectors
free of the system board.

Figure 5-23. Disconnecting the Display Cables

NOTE:  Do not pull the connector by the wires from the socket. The wires will be
damaged, rendering the display inoperative.
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5. Close the display.

6. Remove the remaining screw from the left display clutch and the two screws from
the right display clutch.

7. Lift the display assembly from the base enclosure.

Figure 5-24. Removing the Display Assembly

Reverse the procedure to replace the display assembly.

CAUTION:  To avoid damaging the display, attach the ground cable before attaching the
display cables when replacing the display assembly.

Note: Always replace the four loctite screws with the replacement screws supplied in the
service kit.
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5.9  Top Cover Assembly

To remove the top cover assembly, complete the following procedures:

1. Prepare the computer for disassembly (Page 5-3).

2. Remove the keyboard (Page 5-14).

3. Remove the optical disc bay device (Page 5-22).

4. Remove the RTC battery (Page 5-20).

5. Complete steps 1 through 4 of the display assembly removal procedure (Page 5-23).

6. Remove the seven (7) screws holding the top and bottom of the base enclosure
together.

Figure 5-25. Removing the Top Cover Assembly Screws from the Bottom

of the Unit
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7. Remove the three (3) top cover screws from the back of the system unit.

Figure 5-26. Removing the Top Cover Assembly Screws from the Back of the Unit
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CAUTION:  Do not use the attached wiring to pull the connectors out of the sockets. This
will damage the wire and render the top cover unusable.

8. Disconnect the speaker1,2, touchpad3, indicator4, and switch5 cables from the
system board. Use the tweezers to release the connectors from the sockets.

Figure 5-27. Disconnecting the Cable from the System Board
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9. Lift the top cover from the base enclosure.

Figure 5-28. Removing the Top Cover Assembly

To replace the top cover assembly, reverse the steps.
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DC-DC Converter and Audio Board

To remove the DC-DC converter, complete the following procedures:

1. Prepare the computer for disassembly (Page 5-3).

2. Remove the keyboard (Page 5-14).

3. Remove the RTC battery (Page 5-34).

4. Remove the top cover assembly (Page 5-27).

5. Remove the screws from the converter/audio board shield.

6. Remove the converter/audio board shield.

Figure 5-29. Removing the DC-DC Converter and Audio Board Shield
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7. Remove the DC-DC converter board from the system board.

Figure 5-30. Removing the DC-DC Converter
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Audio Board

CAUTION:  The Audio board is relatively fragile. Do not twist or bend during disassembly
or replacement.

To remove the audio board, complete the following procedures:

1. Prepare the computer for disassembly (Page 5-3).

2. Remove the keyboard (Page 5-14).

3. Remove the RTC battery (Page 5-20).

4. Remove the top cover assembly (Page 5-27).

5. Remove the converter/audio board shield (Page 5-31).

6. Separate the audio board from the system board. Note that there are two connectors
on the audio board. Gently lift at both connectors, being careful not to twist or stress
the board.

Figure 5-31. Removing the Audio Board

To replace the audio board, reverse the steps.

CAUTION:  To ensure proper connection when mating the audio board to the system
board, be certain both connectors are fully engaged before continuing with the re-
assembly procedure. Unless the audio board is fully seated at both ends, the system
may not start, may not have audio/led functions, or may have no video.
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Fan

To remove the fan, complete the following procedures:

1. Prepare the computer for disassembly (Page 5-3).

2. Remove the keyboard (Page 5-14).

3. Remove the RTC battery (Page 5-20).

4. Remove the top cover assembly (Page 5-27).

5. Remove the converter/audio board shield (Page 5-31).

6. Disconnect the fan power cable from the system board.

7. Remove the fan from the computer base.

Figure 5-32. Removing the Fan

Reverse the procedure to install the fan.

IMPORTANT:  When installing the fan, orient the fan so that the label and airflow
direction point to the back of the computer.
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System Board

To remove the system board, complete the following procedures:

1. Prepare the computer for disassembly (Page 5-3).
2. Remove the hard drive (Page 5-11).
3. On modem equipped models, remove the modem (Page 5-7).
4. On IR equipped models, remove the IR module(Page 5-10).
5. Remove the keyboard (Page 5-14).
6. Remove the lithium real-time clock battery (Page 5-20).
7. Remove the top cover assembly (Page 5-27).
8. Remove the DC-DC Converter (Page 5-31).
9. Remove the audio board (Page 5-33).

10. Remove the fan (Page 5-34).
11. Disconnect the system board power input cable from the AC adapter.

Figure 5-33. Disconnecting the Power Input Connector from the System Board
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12.  Remove both hex screws from the rear of the base enclosure.

13. Remove the screw from the system board.

Figure 5-34. Removing the Alignment Guides from the Expansion Connector



Removal and Replacement Procedures    5-37

14. Lift the right end of the system board 1 from the lower base enclosure.

15. Slide the system board to the right 2 and lift it from the base enclosure.

Figure 5-35. Removing the System Board

To replace the system board, reverse the steps.
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Integrated AC Adapter

To remove the AC power module, complete the following procedures:

1. Prepare the computer for disassembly as described on page 5-3.

2. Remove the system board  (Page 5-35).

3. Remove the ground lead screw.

4. Remove the two screws holding the AC adapter to the system base.

5. Remove the two screws holding the AC power input connector to the back panel of
the system base.

6. Lift the AC adapter from the system base enclosure.

Figure 5-36. Removing the AC Adapter

To replace the AC adapter, reverse the procedures described.

NOTE:  If you are replacing the base enclosure, transfer the IR module to the new
enclosure.
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chapter
 6

SPECIFICATIONS

This chapter provides physical and performance specifications for the following:

■ Computer

■ Displays

■ Hard drives

■ Diskette drive

■ LS-120 drive

■ ZIP drive

■ CD-ROM drive

■ DVD-ROM drive

■ Battery packs

■ Convenience Base

■ External power sources

The chapter also includes:

■ System interrupts

■ System DMA

■ System I/O address

■ System memory map
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6.1  Computer

Table 6-1
Computer Specifications

U.S. Metric

Dimensions
  Height
  Depth
  Width

2.3 in
9.6 in
12.5 in

5.84 cm
24.5 cm
31.75 cm

Weight

  With battery and optional CD-ROM 8.3 lbs 3.55 kg

Standalone (Battery) Power Requirements

  Nominal Operating Voltage (Li-Ion) 14.2 14.2

  Nominal Operating Voltage (NiMh) 9.6 9.6

  Maximum Operating Power 45 W 45 W

  Peak Operating Power 50 W 50 W

Integrated AC Power Power Requirements

  Operating Voltage 100 to 240 VAC RMS 100 to 240 VAC RMS

  Operating Current 1.1 A RNS 1.1 A RMS

  Operating Frequency Range 47 to 63 Hz AC 47 to 63 Hz AC

  Maximum Transient 4/50 kV 4/50 kV

Temperature

  Operating 5 to   95°F   10 to 35°C

  Nonoperating -4 to 140°F -30 to 60°C

Relative Humidity (noncondensing)

  Operating 10 to 90% 10 to 90%

  Nonoperating  (tw = 38.7°C max)   5 to 90%   5 to 90%

Altitude

  Operating 0 to 10,000 ft 0 to 3.15 km

  Nonoperating 0 to 30,000 ft 0 to 10.14 km

Shock

  Operating   10 G, 11 ms, half sine

  Non operating   240 G, 2 ms, half sine

Vibration

  Operating 0.55 G, 0.25 Oct/Min sweep rate

  Nonoperating 1.5 G, 0.5 Oct/Min sweep rate

NOTE:  Applicable product safety standards specify thermal limits for plastic surfaces. The Compaq

Armada operates well within this range of temperatures.
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6.2  Display

Table 6-2
12.1-Inch CTFT, SVGA Display

U.S. Metric

Dimensions
  Height
  Width

7.24 in
9.7 in

18.4 cm
24.6 cm

Number of Colors 64K

Contrast Ratio 100:1 minimum

Pixel Resolution
  Pitch
  Format
  Configuration

0.30 × 0.30 mm
800 × 600
RGB Stripe

Backlight Edge Lit

Character Display 80 × 25

Table 6-3
13.3-Inch CTFT, XGA Display

U.S. Metric

Dimensions

  Height 7.9 in 20.1 cm
  Width 10.6 in 26.9 cm

Number of Colors 64K

Contrast Ratio 100: 1 minimum

Pixel Resolution
  Pitch
  Format
  Configuration

0.29 x 0.29 mm
1024 x 768
RGB Stripe

Backlight Edge Lit

Character Display 80 × 25
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6.3 Hard Drives

Table 6-4
Hard Drive Specifications

Standard Model Configurations 4.0-GB

Formatted Capacity per Drive (MB)

  Physical

  Logical 4,099,866,624

Drive Type

Drive Height

  With drive frame (mm) 12.7

Drive Size

  Inches 2.5 x 0.5

  Millimeters 102 x 75

Transfer Rate

  Media (Mb/s) 51.4-83.4 MB/sec

  Interface (Mb/s) 16.6 MB/sec

Sector Interleave 1:1

Typical Seek Time (Including setting)

  Single Track (ms) 4 ms

  Average (ms) 13 ms (read)

  Full Stroke (ms) 32 ms (read)

Disk Rotational Speed (RPM) 4009

Physical Configuration

  Cylinders 6975

  Data Heads 6

  Sectors/Track 144-240

  Bytes/Sector 512

Logical Configuration

  Cylinders 7944

  Heads 16

  Sectors per Track 63

  Bytes per Sector 512

Buffer Size 512-KB
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6.4 Diskette Drive

Table 6-5
Diskette Drive Specifications

Diskette size 3.5-inch

  High density 1.44-MB/1.2-MB

  Low density 720 KB

Light None

Height 0.43-in (11 mm)

Bytes per sector 512

Sectors per Track

  High density 18 (1.44-MB)/15 (1.2-MB)

  Low density   9

Tracks per Side

  High density 80 (1.44-MB)/80 (1.2-MB)

  Low density 80

Read/Write heads   2

Average Seek Times

  Track-to-Track (high/low)     3 ms/6 ms

  Average (high/low)   94 ms/174 ms

  Settling Time   15 ms

  Latency Average 100 ms
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6.5 LS-120 Drive

Table 6-6
LS-120 Drive Specifications

120 MB 1.7 MB DMF 1.44 MB 1.2 MB 1.2 MB 720 KB 640 KB

Formatted
Capacity (Bytes)

125,958,144 1,720,320 1,474,560 1,261,568 1,228,800 737,280 655,360

Sector Size
(bytes)

512 512 512 1024 512 512 512

Sectors 246,527 3360 2880 1,232 2400 1,440 1,280

Magnetic Tracks/
Surface

1736 80 80 77 80 80 80

Optical Servo
Tracks/Surface

900 N/A N/A N/A N/A N/A N/A

Sectors/track 51-92 21 18 8 15 9 8

Sector Interleave 1:1 2:1 1:1 1:1 1:1 1:1 1:1

Spare sectors 170 0 0 0 0 0 0

Zones (each side) 55 1 1 1 1 1 1

Average
random seek

70 ms 70 ms 70 ms 70 ms 70 ms 70 ms 70 ms

Track-to-Track
seek

20 ms 25 ms 25 ms 25 ms 25 ms 25 ms 25 ms

Max single seek 120 ms 170 ms 170 ms 170 ms 170 ms 170 ms 170 ms

Average Latency 41.67 ms 41.67 ms 41.67 ms 41.67 ms 41.67 ms 41.67 ms 41.67 ms

Motor rpm 720
 ±0.5%

720
 ±0.5%

720
 ±0.5%

720
 ±0.5%

720
 ±0.5%

720
 ±0.5%

720
 ±0.5%

Motor Start Time, 800 ms 800 ms 800 ms 800 ms 800 ms 800 ms 800 ms

Track Density 2,490 TPI 135 TPI 135 TPI 135 TPI 135 TPI 135 TPI 135 TPI

Track Width 8 µm 125 µm 125 µm 125 µm 125 µm 125 µm 125 µm

Encoding Method (1,7)RLL MFM MFM MFM MFM MFM MFM

Max Flux Density 33,660 FCI 17,334 FCI 17,334 FCI 17,334
FCI

17,334
FCI

8,717 FCI 8,717 FCI

Recording
Density

44,880 BPI 17,334 BPI 17,334 BPI 17,334
BPI

17,334
BPI

8,717 BPI 8,717 BPI

Nominal Transfer
Rate

375-680
KB/sec

150
KB/sec

150
KB/sec

125
KB/sec

125
KB/sec

75
KB/sec

75
KB/sec

Nominal
Sustained
Transfer Rate
across interface

313-565
KB/sec

65 KB/sec
Read,
32 KB/sec
Write

55 KB/sec
Read,
28 KB/sec
Write

49 KB/sec
Read,
25 KB/sec
Write

46 KB/sec
Read,
23 KB/sec
Write

28 KB/sec
Read,
14 KB/sec
Write

28 KB/sec
Read,
14 KB/sec
Write

Buffer Transfer
rate

4.0
MB/sec

4.0
MB/sec

4.0
MB/sec

4.0
MB/sec

4.0
MB/sec

4.0
MB/sec

4.0
MB/sec
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6.6 ZIP Drive

Table 6-7
ZIP Drive Specifications

Total Formatted Capacity (bytes) 100,663,296

Sector Size (bytes) 512

Total Number of Sectors 196,608

Number of Reassignable Spare Sectors 252

Sector Interleave 1:1

Number of Zones (each side) 4

Sectors per Track, Zone 0 72

Sectors per Track, Zone 1 60

Sectors per Track, Zone 2 48

Sectors per Track, Zone 3 40

Magnetic Track/Surface 908

Compaq Part Number for Diskette 270928-001

Seek Times (including settling)

Average Seek 29 ms

Track-to-Track 5 ms

Maximum 55 ms

Average Latency 10 ms

Motor Speed (rpm) 2941 ±5%

Motor Start Time (ms) 3000

Track Density (TPI) 2118

Track Width (µm) 12

Encoding Method (1,8) RLL

Max Flux Density (FCI) 34,560

Max Recording Density (BPI) 46,000

Transfer Rate From Diskette (kb/sec.) 790-1400

Buffer Transfer Rate (maximum, MB/sec) 3.3
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6.7 CD-ROM Drive

Table 6-8
CD-ROM Specifications

Applicable Disc CD-ROM mode 1, mode 2

CD-Digital Audio

CD-XA mode 2 (Form 1, Form 2)

CD-I mode 2 (Form1, Form 2)

CD-I Ready

CD-Bridge

CD-WO (fixed/variable packets)

Photo CD (singlemultisession)

Center Hole Diameter 15 mm

Disc Diameter 12 cm, 8 cm

Disc Thickness 1.2 mm

Track Pitch 1.6  µm

Laser

  Beam Divergence 53.5 ± 1.5 degrees

  Output Power 0.24 ± 0.1 mw

  Type Semiconductor Laser GaA1As

  Wave Length 780 nm ± 25 nm

Access time

  Random <350 ms

  Full Stroke <750 ms

Audio output level

  Line Out 0.7 Vrms

  Headphone None

Cache buffer 128 KB

Data transfer rate

  Sustained, 10x 1500 KB/sec

  Sustained, single 150 KB/sec

  Burst 8.3 MB/sec

  Startup Time <8 seconds typical

Capacity

Mode 1, 12 cm 550 MB

Mode 2, 12 cm 640 MB

8 cm 180 MB
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6.8 DVD-ROM Drive

Table 6-9
DVD-ROM Specifications

Disc Formats Supported DVD-5, DVD-9, DVD-10, DVD-18

CD-ROM mode 1, mode 2

CD-Digital Audio

CD-XA mode 2 (Form 1, Form 2)

CD-I mode 2 (Form1, Form 2)

CD-I Ready

CD-Bridge

CD-R

Photo CD (singlemultisession)

Center Hole Diameter 15 mm

Disc Diameter 12 cm, 8 cm

Disc Thickness 1.2 mm

Track Pitch 1.6  µm

Capacity 4.7-GB - DVD-5

8.5-GB - DVD-9

9.4-GB - DVD-10

550-Mbytes (Mode 1, 12)

640 Mbytes (Mode 2, 12 cm)

180 Mbytes (8 cm)

17.1 - DVD -18

Laser

  Output Power 5mw

  Type Semiconductor Laser GaA1As

  Wave Length 650 nm ± 25 nm (DVD Mode)

795 nm ± 25 nm (CD-ROM mode)

Access time

  Random <200 ms

  Full Stroke <250 ms

Audio output level

  Line Out 0.7 Vrms

  Headphone None

Cache buffer 128 KB

Data transfer rate

  Sustained, 1x (CD-ROM mode) 150 KB/sec

  Sustained, 20x CD-ROM CAV mode 1200-3000 KB/sec

  Sustained, DVD mode 2760 Kbytes/s sustained, DVD mode

  Burst 16.6 MB/sec

  Startup Time <15 seconds typical
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6.9 Battery Packs

Table 6-10
Lithium Ion Battery Pack

U.S. Metric

Dimensions
 Height
 Length
 Width

.82 in
5.8 in
3.2 in

2.08 cm
14.73 cm
8.13 cm

Weight .85 lb .39 kg

Electrical

  Voltage 14.4 V

  Amp-hour capacity 2.7 Ah

  Watt-hour capacity 40 Wh

Environmental Requirements

  Operating temperatures   50°F to 104°F  10°C to 40°C

  Nonoperating temperatures -12°F to 140°F -30°C to 60°C
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6.10 Convenience Base

Table 6-11
Convenience Base Specifications

U.S. Metric

Dimensions

  Height   4.9 in   12.46 cm

  Height w/Monitor Stand   5.2 in   13.208 cm

  Length   14.7in   37.34 cm

  Width  14.2 in 36.07 cm

Weight

  Expansion Base 4.25 lbs 1.93 kg

  Expansion Base w/Monitor Stand 5.8 lbs 2.63 kg

Power Supply (Input)

  Operating Voltage 100 to 240 VAC

  Operating Current 1.10 Amp Maximum

  Rated Voltage 100 to 240 VAC

  Rated Current 1.0 Amp Maximum

  Line Frequency 47 to 63 Hz.

Temperature

  Operating 50 to 95°F 10 to 35°C

   Storage -4 to 140°F 20 to 60°C

Relative Humidity

  Operating 10 to 90%

  Storage   5 to 95%

Altitude

  Operating 10,000 ft 3.15 km

  Nonoperating 30,000 ft 10.14 km

Shock

  Operating 10 G, 11 ms, half sine

  Nonoperating 140 G, 2 ms, half sine

Vibration

  Operating 0.25 G, 5 to 500 Hz, 0.5 octave/min sweep rate

  Nonoperating 1.0 G, 5 to 500 Hz, 0.5 octave/min sweep rate
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6.11 External Power Supplies

The automobile/aircraft adapter allows the computer to be used in an automobile or in
an aircraft without a drain on the computer's batteries.

Table 6-12
Automobile/Aircraft Adapter

U.S. Metric

Dimensions

  Height 1.42 in 3.6 cm

  Width 2.83 in 7.2 cm

  Length 4.84 in 12.3 cm

Weight .88 lb 0.4 kg

Input Cord Length 39 in 1 m

Power Supply (Input)

  Nominal Voltage 13.8 VDC

  Operating Voltage 10.5 - 14.8 VDC

  Maximum Voltage 16.0 VDC

  Input Fuse Protection 8.0 A

Power Supply (Output)

  Nominal Voltage 120 VAC

  Load Regulated Voltage 108 - 125 VAC

  Line Regulated Voltage 105 to 125 VAC

  Output Frequency 60 Hz +/- 3 Hz

  Output Overload Protection 150W @ 2 sec.

Temperature

  Operating 32 to 104°F     0 to 40°C
  Nonoperating  -4 to 140°F  -20 to 60°C

Relative Humidity

  Operating 10 to 90%

  Nonoperating   5 to 95%
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The external battery charger charges the Li-Ion battery outside the computer. It may
also be used to charge spare batteries.

Table 6-13
External Battery Charger

U.S. Metric

Dimensions

  Height 1.57 in 40 mm

  Width 5.25 in 133 mm

  Length 9.4 in 239 mm

Weight 1.1 lb 4.95 gm

Power Supply (Input)

  Nominal Voltage 100 - 240 VAC

  Line frequency 47-63 Hz

Power Supply (Output)

  Nominal Voltage +18.5 +/- 0.25 VDC

  Power 40 to 42 W

Temperature

  Operating 41 to 104°F 5 to 40°C
  Nonoperating -4 to 185°F -20 to +85°C

Relative Humidity

  Operating 10 to 95%

  Nonoperating 10 to 95%
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6.12 System Interrupts

Table 6-14
Hardware Interrupts

Hardware IRQ System Function

IRQ0 Timer interrupt

IRQ1 Keyboard

IRQ2 Interrupt controller cascade

IRQ3 COM 2

IRQ4 COM 1

IRQ5 Audio

IRQ6 Diskette Drive controller

IRQ7 EPP Parallel

IRQ8 Real-Time Clock (MSIO)

IRQ9 PCI devices

IRQ10 Unused

IRQ11 Used by PCMCIA

IRQ12 Mouse

IRQ13 Floating point error input

IRQ14 Primary IDE interface

IRQ15 Secondary IDE interface

6.13 System DMA

Table 6-15
DMA Channels

Hardware DMA System Function

DMA 0 Fast infrared or Audio controller

DMA 1 Audio controller

DMA 2 Diskette drive controller

DMA 3 EPP Parallel Port

DMA 4 Not assigned

DMA 5 Audio Controller

DMA 6 Not assigned

DMA 7 Not assigned
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6.14 System I/O Address

Table 6-16
System I/O (Port) Addresses

I/O Address (Hex) System Function (Shipping Configuration)

000 - 00F Master DMA Controller # 1

010 - 011 Force Software SMI

012 - 01F Unused

020 - 021 Peripheral Interrupt Controller # 1

022 - 024 Chipset Configuration Registers

025 - 03F Unused

040 - 043 Counter/Timer Registers

044 - 05F Unused

060 Keyboard Data

061 Port B

062 - 063 Unused

064 Keyboard Command/Status

065 - 06F Unused

070 CMOS Index Address

071 CMOS Data

072 - 073 Unused

074 Reserved

075 Unused

076 Reserved

077 - 077F Unused

080 - 08F DMA Page Registers

084 - 085 POST Code Output Port

090 - 091 Unused

092 Fast Reset Register

093 - 09F Unused

0A0 - 0A1 Interrupt Controller # 2

0A2 - 0BF Unused

0C0 - 0DF DMA Controller # 2

0E0 - 0E1 ESS Audio Configuration

0E2 - 0E5 Configuration Registers

0E6 - 0EF Unused

0F0 - 0F1 NCP Numerics Register

0F9 ESS Configuration Lock

0FA Unused

0FB ESS Configuration Unlock

0FC - 0FF Unused

100 - 101 Unused

103 - 16F Unused

Continued
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Table 6-16   Continued

I/O Address (Hex) System Function (Shipping Configuration)

170 - 177 Hard Drive Secondary Registers

178 - 1EF Unused

1F0 - 1F7 Hard Drive Primary  Registers

1F8 - 1FF Unused

200 - 21F Unused

220 - 22F ESS Audio Registers (1st Possible) (Default)

230 - 23F ESS Audio Registers (2nd Possible)

240 - 24F ESS Audio Registers (3rd Possible)

250 - 25F ESS Audio Registers (4th Possible)

260 - 277 Unused

278 - 27A LPT2  and High Speed Parallel Port  Registers

27B - 27F LPT2 High Speed Printer Port Registers

280 - 2F7 Unused

2F8 - 2FF Serial Control Register COM2

300 - 36F Unused

370 - 371 Reserved

372 Diskette Digital Output Register

373 Unused

374 Reserved

375 Diskette Main Status/Data Registers

376 Reserved

377 Diskette Input/Control Registers

378 - 37A LPT1 and High Speed Parallel Port Registers

37B - 37F Unused

380 - 387 Unused

388 - 38B ESS FM Synthesizer

38C - 3AF Unused

3B0 - 3BB Unused

3BC - 3BE LPT3 and High Speed Parallel Port  Registers

3BF LPT1 High Speed Parallel Port Registers

3C0 - 3CD Unused

3D0 - 3DF Unused

3F0 - 3F7 Diskette Drive Controller Primary Registers

3F8 - 3FF COM1 Serial Controller Registers

400 - 4CF Unused

480 - 48F Extended DMS Registers

4D0 - CF6 Unused

CF7 Configuration/NVM Data Register

CF8 - CFB PCI Configuration Index Register

CFC - CFF PCI Configuration Index Register

D00 - FFF Unused
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6.15 System Memory Map

Table 6-17
Memory Map

Size Memory Address System Function

640 K 00000000 - 0009FFFF Base Memory

128 K 000A0000 - 000BFFFF Video Memory

  48 K 000C0000 - 000CBFFF Video BIOS

160 K 000C8000 - 000E7FFF Unused

  64 K 000E8000 - 000FFFFF System BIOS

 15 M 00100000 - 00FFFFFF Extended Memory

 58 M 01000000 - 047FFFFF Super Extended Memory

 58 M 04800000 - 07FFFFFF Unused

   2 M 08000000 - 080FFFFF Video Memory (Direct Access)

   4 G 08200000 - FFFEFFFF Unused

 64 K FFFF0000  - FFFFFFFF System BIOS ("SHADOW")
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appendix
 A

CONNECTORS

This appendix contains the pin assignments for all external connectors.

Table A-1
External Keyboard

Connector Pin Signal

KEY

65

43

21
1

2

3

4

5

6

Data

Unused

Ground

+5 VDC

Clock

Unused

Table A-2
PS/2-Compatible Mouse

Connector Pin Signal

KEY

65

43

21
1

2

3

4

5

6

Data

Unused

Ground

+5 VDC

Clock

Unused

Table A-3
Ethernet RJ-45

Connector Pin Signal

6
5

4
3

2
1 7

8

1

2

3

4

5

6

7

8

(+) Transmit Data

(-) Transmit Data

(+) Receive Data

Unused

Unused

(-) Receive Data

Unused

Unused
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Table A-4
USB

Connector Pin Signal

1
2
3
4

Ground
- Data
+ Data
+5 VDC

Table A-5
External Monitor

1

6

11

5

10

15

Pin Signal Pin Signal

1 Red Analog   9 Blank

2 Green Analog 10 Ground

3 Blue Analog 11 Blank

4 Blank 12 Monitor ID (DD)

5 Ground 13 Horizontal Sync

6 Ground 14 Vertical Sync

7 Ground 15 Monitor ID (CC)

8 Ground
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Table A-6
Parallel

1

14 25

13

Pin Signal Pin Signal

Strobe 14 Auto Linefeed

  2 Data Bit 0 15 Error

  3 Data Bit 1 16 Initialize Printer

  4 Data Bit 2 17 Select In

  5 Data Bit 3 18 Ground

  6 Data Bit 4 19 Ground

  7 Data Bit 5 20 Ground

  8 Data Bit 6 21 External Diskette Positive Drive Detect

  9 Data Bit 7 22 External Diskette Negative Drive Detect

10 Acknowledge 23 Ground

11 Busy 24 Ground

12 Paper End 25 External Diskette Drive Switched to +5 V

13 Select

Table A-7
Serial

1

6 9

5

Pin Signal Pin Signal

1 Carrier Detect 6 Data Set Ready

2 Receive Data 7 Ready to Send

3 Transmit Data 8 Clear to Send

4 Data Terminal Ready 9 Ring Indicator

5 Ground
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Table A-8
Expansion Connector

Pin Signal Pin Signal

  1 GND 31 GREEN

  2 GND 32 CRTVSYNC

  3 NC 33 RED

  4 GND 34 DDCCLK

  5 GND 35 PWRLED

  6 NC 36 DDCDATA

  7 GND 37 DOCK_PWR_EN

  8 GND 38 GND

  9 AD[31] 39 SPKL

10 DEVSEL 40 LINE_L

11 IRDY 41 SPK_R

12 STOP 42 LINE_R

13 TRDY 43 GND

14 GND 44 DOCK_LG

15 GND 45 GND

16 AD[12] 46 GND

17 AD[13] 47 REQ1

18 GND 48 REQ0

19 GND 49 GNTO

20 CLK1 50 RST

21 AD[0] 51 GND

22 GND 52 AD[23]

23 DOCK_S 53 AD[22]

24 CLK0 54 C/BE2

25 ACVCC 55 AD[20]

26 ACVCC 56 NC

27 ACVCC 57 AD[19]

28 ACVCC 58 FRAME

29 ACVCC 59 AD[17]

30 CRTHSYNC 60 GND

Continued
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Table A-8Continued

Pin Signal Pin Signal

61 GND   96 GND

62 AD[14]   97 CBE3

63 AD[15]   98 AD[21]

64 AD[1]   99 NC

65 AD[3] 100 NC

66 AD[2] 101 AD[18]

67 GND 102 C/BE1

68 MDATA 103 PAR

69 KBDATA 104 GND

70 MCLK 105 AD[16]

71 KBCLK 106 AD[6]

72 ACVCC 107 C/BE0

73 PMVCC5 108 AD[5]

74 PMVCC5 109 AD[7]

75 NC 110 AD[4]

76 BLUE 111 BATTLED

77 NC 112 SWC

78 PBUSY 113 TA

79 PDATA7 114 SWB

80 PBDATA3 115 SWD

81 PSLIN 116 SWA

82 GND 117 PMVCC5

83 GND 118 PMVCC5

84 SPK_IN 119 PMVCC5

85 +5v 120 PMVCC5

86 NC 121 PSELECT

87 ERDY 122 PDADA6

88 SYSVCC5A 123 PACK

89 STANDBy_SW 124 PDATA2

90 NC 125 PDATA0

91 NC 126 PFAULT

92 NC 127 GND

93 NC 128 GND

94 GNT1 129 DSRA

95 GND 130 DCDA

Continued
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Table A-8 Continued

Pin Signal Pin Signal

131 RTSA 154 AD[8]

132 RIA 155 PORT_REP

133 POWER_SW 156 MSI

134 INTB 157 MSO

135 NC 158 TC

136 INTA 159 TD

137 NC 160 TB

138 GND 161 PMVCC5

139 NC 162 PMVCC5

140 AD[27] 163 PPE

141 AD[30] 164 PMVCC5

142 AD[26] 165 PDATA4

143 AD[29] 166 PDATA5

144 AD[25] 167 PDATA1

145 AD[28] 168 PINIT

146 AD[24] 169 PSTB

147 BLOCK 170 PAFD

148 GND 171 GND

149 PERR 172 GND

150 SERR 173 CTSA

151 AD[11] 174 SINA

152 AD[9] 175 DTRA

153 AD[10] 176 SOUTA
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Table A-9
Speaker Connector

Pin Signal

1 Shield

2 Left channel audio

3 Right channel audio
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POWER CORD SET REQUIREMENTS

3-Conductor Power Cord Set

The wide range input feature of your computer permits it to operate from any line
voltage from 100 to 240 volts AC.

The power cord set received with the computer meets the requirements for use in the
country where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country
where you use the computer.

General Requirements

The requirements listed below are applicable to all countries:

1. The length of the power cord set must be at least 5.00 feet (1.5 m) and a maximum
of 6.56 feet (2.0 m).

2. All power cord sets must be approved by an acceptable accredited agency
responsible for evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC
320 Standard Sheet C5 connector, for mating with appliance inlet on the product.
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Country-Specific Requirements

3-Conductor Power Cord Set Requirements � By Country

Country Accredited Agency Applicable Note Numbers

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan JIS 3

Norway NEMKO 1

Sweden SEMKO 1

Switzerland SEV 1

United Kingdom BSI 1

United States UL 2

Notes:

1. The flexible cord must be <HAR> Type HO3VV-F, 3-conductor,  0.75 mm2

conductor size. Power cord set fittings (appliance coupler and wall plug) must bear
the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SPT-2 or equivalent, No. 18 AWG, 3-conductor.
The wall plug must be a two-pole grounding type with a NEMA 5-15P (15A, 125V)
or NEMA 6-15P (15A 250V) configuration.

The appliance coupler, flexible cord, and wall plug must bear a "T" mark and
registration number in accordance with the Japanese Dentori Law. The flexible cord
must be Type VCT or VCTF, 3-conductor, 0.75mm2 conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303
(15A, 125V) configuration.
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CONVENIENCE BASE

C.1  Models and Features

The convenience bases provide a permanent desktop solution for the computer by
eliminating the need to disconnect external devices such as a printer, keyboard, or
monitor when you undock the computer. All necessary connections and disconnections
are made automatically when the computer is docked and undocked. The following
convenience models are available:

Table C-1
Convenience Bases

Model Serial Configuration

Convenience Base Pass Through model BNH3 (Armada 1500 base)

Convenience Base with Ethernet BNH1 (Armada 1500 base)

Convenience Base II Pass Through model CBY1

Convenience Base II with Ethernet CBX1

Figure C-1. Compaq Armada 1700 Convenience Base
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C.2  Convenience Base II Features

The Convenience Base pass through models and the convenience base with Ethernet
models include the following features:

Convenience

Base

pass

through

Convenience

Base

with

Ethernet

(BNC)

Convenience

Base

with

Ethernet

(RJ45)

Convenience

Base II

pass

through

Convenience

Base II

with

Ethernet

Connections

Speaker/headphone ■ ■ ■ ■ ■

Audio Line-In ■ ■ ■ ■ ■

Serial ■ ■ ■ ■ ■

Parallel ■ ■ ■ ■ ■

External Monitor ■ ■ ■ ■ ■

Keyboard ■ ■ ■ ■ ■

Pointing Device ■ ■ ■ ■ ■

MIDI/Joystick ■ ■ ■ ■ ■

USB ■ ■

Cable lock provision ■ ■ ■ ■ ■

Pass through AC Power ■ ■ ■ ■ ■

RJ-45 connector ■ ■

BNC Connector ■

10-Base-T ■ ■ ■

100-Base-T  (optional) ■

Monitor Stand ■ ■ ■ ■ ■

Localized Power Cords ■ ■ ■ ■ ■

Kensington lock ■ ■ ■ ■ ■
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C.3  Convenience Base II Components

The convenience base components are illustrated and described in this section.

Front and Right Side Components

The front and right side convenience base components are shown and identified in this
section.

1 Docking latches

2 Docking alignment pins

3 Docking connector

4 Power switch

5 Security cable lock

6 Docking lever

7 Pass-through AC power outlet

8 Battery charge light

9 Suspend button

: Power/suspend light

; Retaining latches

Figure C-2. Convenience Base II with RJ45 Front and Right Side Components
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Rear Components

The rear components are shown in the following figure and identified in this section:

1 RJ-45 jack (Ethernet model only)

2 Serial connector

3 Parallel connector

4 External monitor connector

5 MIDI/Joystick connector

6 Pointing device connector

7 Keyboard connector

8 Speaker/headphone jack

9 USB connector

: Audio Line-in jack

; Fan

w AC power connector

Figure C-3. Convenience Base II with RJ45 Rear Components

Table C-2
Convenience Base Models

Item Description Spares Part Number

1 Convenience Base II (Ethernet model) 316312-001

* Convenience Base II (Pass through model) 316291-001

 * Not illustrated
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Table C-3
Convenience Base II Cables and Power Cords

Description Spares Part Number

* AC Power cord (US/Canada) 255135-001

* AC Power cord (Australia/New Zealand) 255135-011

* AC Power cord (UK) 255135-011

* AC Power cord (Europe) 255135-021

* AC Power cord (Italy) 255135-061

* AC Power cord (Denmark) 255135-081

* AC Power cord (Singapore) 255135-111

* AC Power cord (Japan) 255135-291

* AC Power cord (Korea) 255135-AD1

* Not illustrated

Table C-4
Convenience Base II Options

Description Spares Part Number

*  Monitor Stand 316286-001

*  Not illustrated

Table C-5
Convenience Base II Shipping Boxes

Description Spares Part Number

Shipping Carton (5 ea) 210432-001
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Index

A

AC power
removal, 5-38

AC power cord
3-conductor, 2-1
spare part number, 3-5

AC Power Module
spare part number, 3-8

audio
solving problems, 2-19
test error codes, 2-14

audio board
removal, 5-33

audio cable
removal, 5-33

audio/LED board
spare part number, 3-6

automobile/aircraft adapter
spare part number, 3-7
specifications, 6-12

B

base enclosure assembly
spare part number, 3-3

battery
pack
solving problems, 2-21

battery charger
described, 1-3
spare part number, 3-7
specifications, 6-13

battery pack
MultiBay removal, 5-5
removal, 5-4
spare part number, 3-7
specifications, 6-10
temperatures, 6-10

beep codes, 2-6
boot, 2-16

C

cables
handling, 4-2
spare part number, 3-5

CD-ROM drive
caring for, 4-2
removal, 5-22
removing and inserting, 4-2
solving problems, 2-23
specifications, 6-8, 6-9
test error codes, 2-14

clock battery removal, 5-20
clutch covers

removal, 5-23
Compaq Diagnostics, 2-16
Compaq Utilities, 2-7
components

bottom, 1-9
rear, 1-8
right side, 1-7

computer
features
optional, 1-3
standard, 1-2

models, 1-1
specifications, 6-2

computer checkup (TEST)
error codes, 2-10

computer setup, 2-8, 2-9
computer undocking, 5-3
connector

care when handling, 4-2
connector pin assignments

expansion, 1-4
convenience base

described, 1-3
models, 3-1

convenience base components
front and right side, 3-3
rear, 3-4

Convenience Base II
spare part number, 3-7
specifications, 6-11

country kit
spare part number, 3-8

CPU
cover spare part number, 3-3

D

damage, preventing

from electrostatic discharge,
4-3

to cables and connectors, 4-2
to plastic parts, 4-1
to removable drives, 4-2

DC-DC converter
removal, 5-31
spare part number, 3-6

design overview
computer, 1-11

disassembly preparation
computer, 5-3

disassembly sequence, 5-2
disconnecting power, 5-3
diskette drive

caring for, 4-2
error codes, 2-12
removal, 5-5
removing and inserting, 4-2
solving problems, 2-24
spare part number, 3-4
specifications, 6-5, 6-7

display
solving problems, 2-33, 2-35
spare part number, 3-3
specifications, 6-3

display assembly
removal, 5-25

DMA, system, 6-14
documentation spare part

numbers, 3-9
drive

CD-ROM
caring for, 4-2
removing and inserting, 4-2

diskette
caring for, 4-2
removing and inserting, 4-2

hard
caring for, 4-2
removing and inserting, 4-2

E

electrostatic discharge
preventing damage, 4-3
shielding materials, 4-6
typical voltage levels, 4-6
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error codes
audio test, 2-14
CD-ROM test, 2-14
computer checkup (TEST),

2-10
diskette drive test, 2-12
keyboard test, 2-11
memory test, 2-11
parallel printer test, 2-11
pointing device interface

test, 2-14
processor test, 2-10
serial test, 2-12
video test, 2-13

external computer components
bottom, 1-9
front, 1-5
left side, 1-4
rear, 1-8
right side, 1-7
top, 1-6

external connectors
keyboard, 1-1
monitor, 1-2
mouse, 1-1
parallel, 1-3
RJ-45, 1-1
serial, 1-3
speaker, 1-7
USB, 1-2

external keyboards, 1-4
external monitor, 1-4

solving problems, 2-33, 2-35
external pointing devices, 1-4

F

fan
removal, 5-34
spare part number, 3-8

fatal error
beep codes, 2-6
messages, 2-6

features, 1-2
feet, removal, 5-7

G

grounding
equipment and methods, 4-5
packaging and transporting,

4-3

workstations, 4-4

H

hard drive
caring for, 4-2
removal, 5-11
removing and inserting, 4-2
solving problems, 2-25
specifications, 6-4

hard drive adapter
spare part number, 3-7

hard drive cover
spare part number, 3-8

hardware installation
solving problems, 2-26

hardware interrupts, 6-14

I

I/O addresses, 6-15
infrared

connection
solving problems, 2-27

INSPECT, 2-15
installation

memory board, 5-19
interrupt requests (IRQ)

system, 6-14
IR module

spare part number, 3-6
IRQ assignments, 6-14

K

keyboard
external, 1-4
removal, 5-14
spare part number, 3-3
test error codes, 2-11

L

left clutch/display wiring
cover

spare part number, 3-8
lithium clock battery

removal, 5-20
logo kit

spare part number, 3-8

M

magnetic fields, avoiding, 4-2
mass storage devices

spare part number, 3-4
battery pack, 3-4
CD-ROM drive, 3-4
diskette drive, 3-4
hard drive, 3-4

memory
test error codes, 2-11

memory board
installing, 5-19
removal, 5-17
spare part number, 3-6

memory map
system, 6-17

memory options, 1-3
messages

fatal error, 2-6
warning, 2-5

models, 1-1, 3-1
modem

removal, 5-8
solving problems, 2-28
spare part number, 3-6

modem cable
spare part number, 3-5

modem cover
spare part number, 3-8

monitor
optional, 1-4
solving problems, 2-33, 2-35

monitor stand
spare part number, 3-7

MultiBay device
removal, 5-5

O

optional boards
spare part number, 3-6

options, 1-3

P

panel lights, 1-10
parallel port

test error codes, 2-11
pass-through connections,

listing, 3-2
passwords

clearing, 2-3
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PC Card
removal, 5-6
solving problems, 2-31

PCMCIA
removal, 5-6

plastic parts, handling, 4-1
plastics kit

spare part number, 3-8
pointing device

interface test error codes,
2-14

pointing devices
external, 1-4

power
solving problems, 2-32

power cord
general requirements, 2-1

country-specific
requirements, 2-2

requirements, 2-1
spare part number, 3-5

power cord set
notes for 3-conductor, 2-2
spare part number, 3-5

power-on password
clearing, 2-3

processor
test error codes, 2-10

R

removal
audio board, 5-33
audio cable, 5-33
battery pack, 5-4
CD-ROM drive, 5-22
clutch covers, 5-23
DC-DC converter, 5-31
display assembly, 5-23, 5-25
hard drive, 5-11
keyboard, 5-14
memory board, 5-17
modem, 5-8
MultiBay device, 5-5
PCMCIA (PC Card), 5-6
RTC battery, 5-20
speakers, 5-33
system board, 5-35
top cover assembly, 5-27

removal and replacement
preliminaries, 4-1

right clutch/microphone cover
spare part number, 3-8

RTC battery
removal, 5-20
spare part number, 3-5

RTC battery cover
spare part number, 3-8

S

screen
solving problems, 2-33, 2-35

screw kit
spare part number, 3-8

serial
port
test error codes, 2-12

serial number, v
computer, 5-1

service considerations, 4-1
service preliminaries, 4-1
setup password

clearing, 2-3
shielding kit

spare part number, 3-8
shipping drives, 4-2
software

backup, 1-2
fulfillment, 1-2

spare part number
AC power cord, 3-5
automobile/aircraft adapter,

3-7
battery, 3-7
battery charger, 3-7
cables, 3-5
Convenience Base II, 3-7
country kit, 3-8
diskette drive, 3-4
documentation, 3-9
external battery charger, 3-7
hard drive, 3-4
hard drive adapter, 3-7
keyboard, 3-3
logo kit, 3-8
modem cable, 3-5
power cords, 3-5

speakers
removal, 5-33

specifications
automobile/aircraft adapter,

6-12
battery charger, 6-13
battery pack, 6-10
CD-ROM drive, 6-8, 6-9
computer, 6-2
Convenience Base II, 6-11
diskette drive, 6-5, 6-7
display, 6-3
hard drive, 6-4

standard boards
spare part number, 3-6

status panel lights, 1-10
system

DMA, 6-14
I/O address, 6-15
interrupts, 6-14
memory map, 6-17
memory options, 1-3

system board
removal, 5-35
spare part number, 3-6

system information, 2-15
system unit, 3-2

T

technician notes, v
temperatures

battery pack, 6-10
tools required for service, 4-1
top cover assembly

removal, 5-27
spare part number, 3-3

troubleshooting
audio, 2-19
battery, 2-21
CD-ROM drive, 2-23
diskette drive, 2-24
external monitor, 2-33, 2-35
hard drive, 2-25
hardware installation, 2-26
infrared connection, 2-27
modem, 2-28
PC Card, 2-31
power, 2-32
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preliminary steps, 2-2
screen, 2-33, 2-35
without diagnostics, 2-18

V

video display. See display
video test error codes, 2-13

W

warning messages, 2-5
Windows NT

infrared connection, 2-27


